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IQC 5000B Operation Manual
Safety Precautions

The IQC5000 consists of complex precision RF test equipment and electronic hardware.  Care should be taken in 
handling the equipment to limit shock and vibration.
This equipment is not considered user serviceable, and should only be modified or serviced by qualified 
personnel.  Failure to do so may result in damage to the equipment, injury, or even death.

General Safety Precautions

The following are general safety precautions that are not necessarily related to any specific part or procedure, and 
do not necessarily appear elsewhere in this publication. These precautions must be thoroughly understood and 
apply to all phases of operation and maintenance.

WARNING
Keep Away From Live Circuits

Operating Personnel must at all times observe general safety precautions. Do not replace 
components or make adjustments to the inside of the test equipment with the high 

voltage supply turned on. To avoid casualties, always remove power.

WARNING
Do Not Service Or Adjust Alone

Under no circumstances should any person reach into an enclosure for the purpose of 
service or adjustment of equipment except in the presence of someone who is capable of 

rendering aid.

WARNING
Safety Earth Ground

An uninterruptible earth safety ground must be supplied from the main power source to 
test instruments. Grounding one conductor of a two conductor power cable is not 

sufficient protection. Serious injury or death can occur if this grounding is not properly 
supplied.

WARNING
Resuscitation

Personnel working with or near high voltages should be familiar with modern methods of 
resuscitation.

WARNING
Remove Power

Observe general safety precautions. Do not open the instrument with the power on.
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Safety Precautions
Safety Symbols

Note: Calls attention to supplemental information.

WARNING
Take Proper ESD Measures

Handling of electrostatic discharge-sensitive devices is to be done within an approved ESD 
workstation, using appropriate grounding equipment. Compliance to proper ESD protocol 

is essential.

WARNING
Warning notes call attention to a procedure, which if not correctly performed, could result 

in personal injury.

CAUTION
Caution notes call attention to a procedure, which if not correctly performed, could result in 

damage to the instrument.
ii



IQC 5000B Operation Manual
Caution Statements

The IQC5000 consists of complex precision RF test equipment and electronic hardware.  Care should be taken in 
handling the equipment to limit shock and vibration.
This equipment is not considered user serviceable, and should only be modified or serviced by qualified 
personnel.  Failure to do so may result in damage to the equipment, injury, or even death.
The following equipment cautions appear in the text and are repeated here for emphasis.

CAUTION
RF Connector Torque Ratings

When mating RF connectors, ensure that they are properly aligned and not cross-
threaded.  Additionally, do not under/over torque RF connectors, as this could result in 

unreliable results, or worse, damaging the IQC5000.  Always check manufacturer 
specification for proper torque ratings of all RF connectors. The table below defines the 

recommended torque ratings for RF connectors used within the IQC5000.
RF Connector Type Torque Rating (inch-pounds)

SMA 8.0

CAUTION
Use extra care when connecting External MiniSAS HD connectors, the ports are keyed,

but can be forced in upside-down.

CAUTION
Signal strength should not go beyond the range of the spectrum analyzer, as this can 

damage internal components.

CAUTION
Failure to Follow Programming Steps in Correct Order May Result in Device Failure

If the IQC5000 is power-cycled before all steps are taken, or if the unit is programmed out of 
the listed order, the unit may become unresponsive to further programming or cease to 

operate functionally.

CAUTION
Marker and Trigger Input Voltage Should Not Exceed 5V

The operating range for the marker and trigger inputs is 1 to 3.3V DC.  The input voltage 
should not exceed 5V, as this could result in damage to the IQC5000.
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Safety Precautions
Safety Statements

USAGE

ANY USE OF THIS INSTRUMENT IN A MANNER NOT SPECIFIED BY THE MANUFACTURER 
MAY IMPAIR THE INSTRUMENT’S SAFETY PROTECTION.

USO

EL USO DE ESTE INSTRUMENTO DE MANERA NO ESPECIFICADA POR EL FABRICANTE, 
PUEDE ANULAR LA PROTECCIÓN DE SEGURIDAD DEL INSTRUMENTO.

BENUTZUNG

WIRD DAS GERÄT AUF ANDERE WEISE VERWENDET ALS VOM HERSTELLER 
BESCHRIEBEN, KANN DIE GERÄTESICHERHEIT BEEINTRÄCHTIGT WERDEN.

UTILISATION

TOUTE UTILISATION DE CET INSTRUMENT QUI N’EST PAS EXPLICITEMENT PRÉVUE PAR 
LE FABRICANT PEUT ENDOMMAGER LE DISPOSITIF DE PROTECTION DE L’INSTRUMENT.

IMPIEGO

QUALORA QUESTO STRUMENTO VENISSE UTILIZZATO IN MODO DIVERSO DA COME 
SPECIFICATO DAL PRODUTTORE LA PROZIONE DI SICUREZZA POTREBBE VENIRNE 
COMPROMESSA.
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SERVICE

SERVICING INSTRUCTIONS ARE FOR USE BY SERVICE - TRAINED PERSONNEL ONLY. TO 
AVOID DANGEROUS ELECTRIC SHOCK, DO NOT PERFORM ANY SERVICING UNLESS 
QUALIFIED TO DO SO.

SERVICIO

LAS INSTRUCCIONES DE SERVICIO SON PARA USO EXCLUSIVO DEL PERSONAL DE 
SERVICIO CAPACITADO. PARA EVITAR EL PELIGRO DE DESCARGAS ELÉCTRICAS, NO 
REALICE NINGÚN SERVICIO A MENOS QUE ESTÉ CAPACITADO PARA HACERIO.

WARTUNG

ANWEISUNGEN FÜR DIE WARTUNG DES GERÄTES GELTEN NUR FÜR GESCHULTES 
FACHPERSONAL.

ZUR VERMEIDUNG GEFÄHRLICHE, ELEKTRISCHE SCHOCKS, SIND WARTUNGSARBEITEN 
AUSSCHLIEßLICH VON QUALIFIZIERTEM SERVICEPERSONAL DURCHZUFÜHREN.

ENTRENTIEN

L’EMPLOI DES INSTRUCTIONS D’ENTRETIEN DOIT ÊTRE RÉSERVÉ AU PERSONNEL 
FORMÉ AUX OPÉRATIONS D’ENTRETIEN. POUR PRÉVENIR UN CHOC ÉLECTRIQUE 
DANGEREUX, NE PAS EFFECTUER D’ENTRETIEN SI L’ON N’A PAS ÉTÉ QUALIFIÉ POUR CE 
FAIRE.

ASSISTENZA TECNICA

LE ISTRUZIONI RELATIVE ALL’ASSISTENZA SONO PREVISTE ESCLUSIVAMENTE PER IL 
PERSONALE OPPORTUNAMENTE ADDESTRATO. PER EVITARE PERICOLOSE SCOSSE 
ELETTRICHE NON EFFETTUARRE ALCUNA RIPARAZIONE A MENO CHE QUALIFICATI A 
FARLA.
v



About This Manual
About This Manual

This manual covers the operating & maintenance instructions for models:

Changes to this Manual

We have made every effort to ensure this manual is accurate. If you discover any errors, or if you have suggestions 
for improving this manual, please send your comments to our Solon, Ohio factory. This manual may be periodically 
updated. When inquiring about updates to this manual refer to the part number and revision on the title page.

Chapter Layout

Introduction — Describes the features of the IQC5000B RF Recorder, lists equipment supplied and optional 
equipment.
IQC5000 Controls and Indicators — Describes the IQC5000B unit controls, indicators and connectors.
Setup — Describes how to set up the IQC5000B for record and playback.
Spectrum Analyzer Setup — Describes how to set up the spectrum analyzers supported by the IQC5000B; 
Keysight X-Series Spectrum Analyzer Setup, Rohde and Schwarz FSV/FSW, Tektronix RSA6000 Series, and Anritsu 
Field Master Pro MS2090A.
Operating Instructions  — Describes procedures required for operating the IQC5000B.
Using IQC5000 with IQC Control — Provides instruction for installing, and using IQC control software with the 
IQC5000B
Post Processing IQC5000 Recorded Data —  Describes the recorded data file formats.
Troubleshooting — Provides troubleshooting for common connection problems. Specifications and parts 
information are also included.
Maintenance — Lists routine maintenance tasks as well as guidance on building RAID0 arrays and formatting 
external storage units.
Sanitization — Lists the nonvolatile memory components within the IQC5000 system and provides procedures for 
sanitizing the system.
Firmware Configuration Updates — Provides procedures for changing unit operation from Single RAID 
operation to Dual RAID operation or back.
Specifications — Provides specifications for the IQC5000 system.

FCC Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

IQC5000B
vi
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Chapter 1 Introduction

General Description

The IQC5000 enhances the capability of select Keysight, Rohde & Schwarz, Tektronix, and Anritsu Spectrum 
Analyzers (see “Compatible Spectrum Analyzers” on page 4) by increasing their signal storage capacity from seconds 
to hours or days. This capability gives users long duration, high-fidelity spectrum recordings to better analyze 
complex, wideband, time-spanning, or intermittent wave forms.

Figure 1   IQC5000B with IQC-MEM

The IQC5000 can continuously record and play back the full 16 bit I and Q data stream from these Spectrum 
Analyzers:

Table 1 - 

Spectrum Analyzer Bandwidth
Keysight X-Series Up to 255 MHz
Rohde & Schwarz FSW Up to 160 MHz
Tektronix RSA5000 series Up to 165 MHz
Tektronix RSA6000 series Up to 110 MHz
Anritsu Field Master Pro Up to 110 MHz

Recoding Bandwidths

 The IQC5000 utilizes the Low Voltage Differential Signaling (LVDS) serial communication protocol for data transfer at 
very high speed. The IQC5000 is capable of simultaneously recording data from two similar spectrum analyzers 
outputting data at the same sample rate. 
Recording
The IQC-MEM enables recording to either one or two removable internal Solid State Drives (SSD) (Option ME2), or 
one or two external storage units configured for RAID 0 operation. Signals are stored in a non-proprietary format to 
allow analysis by a wide range of digital signal processing tools. The Bird Computer Workstation and Bird’s Spectro-X 
software, provide users a very powerful turn-key digital signal processing capability.
Playback
Recorded broadband signals may be played back with exceptional fidelity from the IQC5000, or used to provide an 
analog I/Q baseband signal to a Vector Signal Generator.
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Introduction
The IQC5000B is capable of I/Q baseband and RF playback. The I/Q Baseband playback is intended for normal use, 
RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.

Available Equipment

Base Models
The IQC5000B is the second generation of the IQC5000 family of products.
The IQC5000B base model is available in three bandwidths:

Table 2 - 

IQC5000B
Model Description

IQC5040B

Signal recorder with up to 40 MHz record bandwidth.
2 LVDS inputs for each I & Q channel, with a maximum data rate of 100 MB/sec per 
connector. 
Includes IQC5000B-MEM interface module, removable AC power supply, IQC Control SW 
and documentation on CD.

IQC5160B

Signal recorder with up to 165 MHz record bandwidth.
2 LVDS inputs for each I & Q channel, with a maximum data rate of 400 MB/sec per 
connector. 
Includes IQC5000B-MEM interface module, removable AC power supply, IQC Control SW 
and documentation on CD.

IQC5255B

Signal recorder with up to 255 MHz record bandwidth.
2 LVDS inputs for each I & Q channel, with a maximum data rate of 600 MB/sec per 
connector. 
Includes IQC5000B-MEM interface module, removable AC power supply, IQC Control SW 
and documentation on CD.

IQC5000B Models

Options and Accessories
The following options and accessories are available for the IQC5000B.

Table 3 - IQC5000B Options and Accessories

Option Description
Memory
IQC5000B-MEM Memory interface module for RAID0 storage units.

IQC5000B-ME2
Internal RAID0 SSD disk storage: 2TB. Supports single channel operation up to 160 MHz 
bandwidth. Two units of option ME2 are required for dual channel operation at bandwidths 
of 160 MHz or single channel operation at 255 MHz.

IQC5000B-ME0 Additional blank memory module cover for the IQC5000B-MEM interface module.

IQC5000B-S08 External RAID0 SSD storage:  8TB, supports single and dual channel operation up to 160 
MHz bandwidth.

IQC5000B-S15 External RAID0 SSD storage:  15TB, supports single and dual channel operation up to 
160 MHz bandwidth.

Recording
IQC5000B-042 Adds second recording channel to support up to 40 MHz recording bandwidth using 2ea 

LVDS inputs, I & Q.
IQC5000B-162 Adds second recording channel to support up to 160 MHz recording bandwidth using 2ea 

LVDS inputs, I & Q.
IQC5000B-XCB LVDS Cable pair (2ea) for Signal Analyzers supporting up to 255 MHz bandwidth.
IQC5000B-ACB LVDS Cable (1ea) for Keysight X-series Signal Analyzers supporting 40 MHz bandwidth.
2



IQC 5000B Operation Manual
IQC5000B-GPS GPS/IRIG-B Timing Standard, includes GPS antenna and interface cable.
IQC5000B-RSX Adapter for Rohde & Schwarz EX-IQ rev 04 interface box. Only compatible with EX-IQ 

boxes with serial numbers above 102000.
Playback
IQC5000B-101 Adds single playback channel to support up to 160 MHz; Baseband I & Q (2ea SMA 

female) and RF Out at 2.4 GHz, 0dBm (1ea SMA female). Not compatible with options 
042, or 162.

IQC5000B-102 Adds second playback channel to support up to 160 MHz; Baseband I & Q (4ea SMA 
female) and one RF Out at 2.4 GHz, 0dBm (1ea SMA female). Requires option 042, or 
162.

IQC5000B-CBL Adds one pair (2ea) of SMA-male to BNC-male cables for IQ analog playback.  Each 
cable is 5 feet long.

PCIe
IQC5000B-PC3 PCIe x4 Express Card 34 host cable adapter for use in laptop computers and systems that 

use option MEM. Includes 2 meter cable.
IQC5000B-PC4 PCIe x8 host adapter for use in desktop computers and systems that use option MEM; full 

height bracket. Includes 2 meter cable.
IQC5000B-PC7 PCIe x8 to x4 cable, 2 meter length.
Computer Workstation
IQC5000B-WS1 Rackmounted SigAnalyst Workstation 

Dual Xeon, Quad-Core Workstation, 64GB RAM with 128 TB HDD Storage Archive (96 TB 
usable)

IQC5000B-WS2 Rackmounted SigAnalyst Workstation 
Dual Xeon, Quad-Core Workstation, 64GB RAM with 128 TB HDD Storage Archive (96 TB 
usable), Spectro-X and RF Editor software packages

WC-RF-EDITOR RF Editor Signal Generation software
SPECTRO-X Spectro-X Advanced Signal Analysis software
Accessories
IQC5000B-RM2 19 inch Rack Mount Kit for IQC5000B with Option MEM (3U)
IQC5000B-1A5 Transit Case for IQC5000B. Case can hold the IQC5000B, IQC5000B-MEM and related 

accessories.
IQC5000B-ENL Rack enclosure to house IQC5000B, down converter, 2ea solid state data packs, 

upconverter, workstation, storage archive and power distribution
IQC5000B-BKT Non-rackmount bracket for affixing the IQC5000B to the IQC5000B-MEM interface 

module
Warranty
IQC5000B-EX1 Extends factory warranty of IQC5000B by one additional year
IQC5000B-EX2 Extends factory warranty of IQC5000B by two additional years
IQC5000B-EX3 Extends factory warranty of IQC5000B by three additional years
IQC5000B-EX4 Extends factory warranty of IQC5000B by four additional years

Option Description
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Compatible Spectrum Analyzers

The IQC5000 is capable of recording digital I/Q data from the following Spectrum Analyzers:

Table 4 - Compatible Spectrum Analyzers

Vendor Compatible Spectrum Analyzer Supported Acq BW

Keysight

N9040B - No Options 19.531 kHz to 10 MHz
N9040B with Option B25 19.531 kHz to 25 MHz
N9040B with Option B40 19.531 kHz to 40 MHz
N9040B with option B85, RTS and RT1 or RT2 19.531 kHz to 85 MHz
N9040B with option B1A, RTS and RT1 or RT2 19.531 kHz to 125 MHz
N9040B with option B1X, RTS and RT1 or RT2 19.531 kHz to 160 MHz
N9040B with Option B2X or B5X, RTS and RT1 or RT2 19.531 kHz to 255 MHz
N9030A/B - No Options 19.531 kHz to 10 MHz
N9030A/B with Option B25 19.531 kHz to 25 MHz
N9030A with Options B1X or B1Y or B85 or B40 and Option 
MPB

19.531 kHz to 40 MHz

N9030B with Options B85, RTS and RT1 or RT2 19.531 kHz to 85 MHz
N9030B with Options B1X, RTS and RT1 or RT2 19.531 kHz to 160 MHz
N9030B with Option B2X or B5X, RTS and RT1 or RT2 19.531 kHz to 255 MHz
N9020A/B or N9010A/B with Option DP2 19.531 kHz to 10 MHz
N9020A/B or N9010A/B with Option B25 and Option DP2 19.531 kHz to 25 MHz
N9010A/B with Option B40 and Option MPB and Option DP2 19.531 kHz to 40 MHz
N9020A/B with Options B1X or B1A or B85 or B40 and Option 
MPB and Option DP2

19.531 kHz to 40 MHz

Rohde & 
Schwarz

FSV with Option B17 and Option B70 and EX-IQ Box 19.531 kHz to 40 MHz
FSVR with Option B17 and EX-IQ Box 19.531 kHz to 40 MHz
FSW with Option B17 and Option B40 and EX-IQ Box 19.531 kHz to 40 MHz
FSW with Option B17 and Option B80 and EX-IQ Box 19.531 kHz to 80 MHz
FSW with Option B17 and Option B160 and EX-IQ Box 19.531 kHz to 160 MHz

Tektronix

RSA6000 Series with Option 05 19.531 kHz to 40 MHz, discrete†

RSA6000 Series with Option 05 and Option 110 19.531 kHz to 110 MHz, discrete†
RSA5000B Series with Option 65 and Option B25 19.531 kHz to 25 MHz, discrete†
RSA5000B Series with Option 65 and Option B40 19.531 kHz to 40 MHz, discrete†
RSA5000B Series with Option 65 and Option B85 or Option 
B85HD

19.531 kHz to 85 MHz, discrete†

RSA5000B Series with Option 65 and Option B16X or Option 
B16XHD

19.531 kHz to 165 MHz, discrete†

RSA5000A Series with Option 25 19.531 kHz to 25 MHz, discrete†
RSA5000A Series with Option 40 19.531 kHz to 40 MHz, discrete†
RSA5000A Series with Option 85 19.531 kHz to 85 MHz, discrete†
RSA5000A Series with Option 110 19.531 kHz to 110 MHz, discrete†
4
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Anritsu

MS2090A wit Option 124 and Option 125 and 
MA25424A IQ Converter

36kHz to 20MHz, discrete†

MS2090A wit Option 124 and Option 125 and Option 103 and 
MA25424A IQ Converter

36kHz to 50MHz, discrete†

MS2090A wit Option 124 and Option 125 and Option 104 and 
MA25424A IQ Converter

36kHz to 110MHz, discrete†

MS2090A wit Option 124 and Option 125 and Option 104 and 
Option 199 and MA25424A IQ Converter

36kHz to 110MHz, discrete†

†. The IQC5000 supports discrete acquisition bandwidths for the Tektronix RSA6000 and RSA5000, and the Anritsu 
Field Master Pro MS2090A Spectrum Analyzers. See “Acquisition Bandwidth” on page 30.

Vendor Compatible Spectrum Analyzer Supported Acq BW
5



IQC5000 Controls and Indicators

Figure 2   IQC5000B/IQC-MEM Front Panel

Table 5 - 
Item Name Description

1 IQC5000B-ME2 Internal RAID0 SSD disk storage: 2TB. Supports single 
channel operation up to 160 MHz bandwidth. 

2 Power Pushbutton Used to apply and remove power to the IQC-MEM unit.

3 Power Pushbutton Used to apply and remove power to the IQC5000B.

4 Front Panel Display Displays current mode and menu.

5 Directional Arrows Used for navigating the front panel menus.

6 MENU Enables the menu on the front-panel display.

7 SELECT Selects available menu option.

8 MARK Inserts a marker while recording.

IQC5000B Front Panel Controls and Indicators
6
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Figure 3   IQC5000B/IQC-MEM Rear Panel

Table 6 - 
Item Option Connector Description

1 Ext. MiniSAS HD Cable connection for IQC5000B.

2 Ext. MiniSAS HD Cable connection for external storage unit

3 Ext. MiniSAS HD Cable connection for external storage unit

4 Aux Jack

5 Power Jack DC input power (12 VDC)

6 SMA (Jack) Local Oscillator In/Out

7 4-Lane PCIe PCI Express interface - not used on IQC5000B

8 Ext. MiniSAS HD Cable connection for IQC-MEM unit. Record directly to external storage

9 Power Jack DC input power (10-14 VDC)

10 DB-9 (Socket) NMEA GPS (Input)

11 042,162 50 pin LVDS Channel 2 I/Q digital input signals

12 SMA (Jack) IRIG-B (Input)

13 SMA (Jack) Marker 1, 2 input (1 - 3.3 VDC, 5 V Max)

14 SMA (Jack) Trigger 1, 2 input (1 - 3.3 VDC, 5 V Max)

15 50 pin LVDS Channel 1 I/Q digital input signals

16 SMA (Jack) 10 MHz Reference In/Out

17 RJ-45 
Receptacle

10/100/1000 MB Ethernet interface

18 Threaded Nut Ground lug

19 101 SMA (Jack) Fixed frequency RF output

20 101 SMA (Jack) Channel 1 I/Q Analog output signals

21 102 SMA (Jack) Channel 2 I/Q Analog output signals

QC5000B Rear Panel Controls and Indicators
7



Chapter 2 Setup

Hardware Setup – Record

Figure 4   Recording Hardware Setup

To set up the hardware for recording:
1. Connect the Power Cables to the following devices:

a. IQC5000 (Note: requires 10-14V power adapter)
b. Spectrum Analyzer (SA)
c. Ethernet Switch
d. Computer Workstation
e. IQC-MEM (Note: requires 10-14V power adapter)
f. (OPTION) External storage unit (s)

2. Connect the LVDS Data Cables from Spectrum Analyzer to IQC5000:
Keysight X-Series (Narrowband Interface up to 40 MHz)
a. Connect the wide end of the LVDS cable from the X-Series Digital Bus Out to the IQC5000 CH 1 I/Q 

Input
Keysight X-Series (Wideband Interface up to 255 MHz)
a. Connect from the X-Series I Out to the IQC5000 CH 1 I Input
8
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b. Connect from the X-Series Q Out to the IQC5000 CH 1 Q Input
Rohde &Schwarz FSV/FSW
a. Mate the RSX adapter with the EX-IQ Z-Dok connector
b. Connect the wide LVDS cables from the RSX I and Q to the IQC5000 CH 1 I/Q Input
c. Connect the EX-IQ data cable from the EX-IQ IN port to the FSV/FSW Digital Baseband OUTPUT port
d. Connect a USB cable from the EX-IQ to the FSW running DigIConf.
e. Connect a BNC cable from the 10MHZ REF OUT on the FSV/FSW to the REF IN on the EX-IQ
Tektronix RSA
a. Connect from the RSA I Out to the IQC5000 CH 1 I Input.
b. Connect from the RSA Q Out to the IQC5000 CH 1 Q Input.
Anritsu Field Master Pro
a. Connect PCIe cable from MS2090A to MA25424A IQ Converter
b. Connect USB cable from MS2090A to MA25424A IQ Converter
c. Connect MA25424A IQ Converter I Out to the IQC5000 CH 1 I Input
d. Connect MA25424A IQ Converter Q Out to the IQC5000 CH 1 Q Input

3. (Option: external storage) Connect cables for the IQC-MEM and external storage units.

a. Connect the External MiniSAS HD to External MiniSAS HD cable to the IQC5000B to MEM port – with 
tab facing down – connect remaining end to the IQC-MEM to IQC port – with tab facing up.

Figure 5   IQC-MEM Cable Connection

b. Connect one end of the External MiniSAS HD cable to the IQC-MEM EXT STORAGE PORT 1, connect the 
remaining end to External Storage Unit data port.

CAUTION
Use extra care when connecting External MiniSAS HD connectors, the ports are keyed,

but can be forced in upside-down.
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Figure 6   IQC-MEM External Storage Cable Connections

c. (Option: 2-channel recording with ONE external SSD storage unit) Connect one end of the External 
MiniSAS HD cable to IQC-MEM EXT STORAGE PORT 2, and the remaining end of the cable to the Exter-
nal Storage Unit data port.

4. (Option: high-speed file transfer) Connect the PCIe Cables.
(IQC-MEM) Connect the PCIe cable from the MEM PCIe x8 slot to the Computer Workstation.

5. Connect Ethernet cables from the Ethernet Switch to the following:
a. IQC5000
b. Spectrum Analyzer
c. Computer Workstation

6. Connect the RF Cables:

a. Connect the RF signal source to the RF IN on the SA.
b. (Recommended) Connect a 10MHz clock reference to the REF IN on the SA.
c. (Recommended) Connect the REF OUT on the SA to the 10MHz REF IN on the IQC5000.

d. (Option: triggers) Connect trigger source(s) to Trigger IN on the IQC5000.
e. (Option: markers) Connect marker source(s) to Marker IN on the IQC5000 (connect NMEA 1PPS to 

Marker 1 if NMEA data is desired).

CAUTION
RF Connector Torque Ratings

When mating RF connectors, ensure that they are properly aligned and not cross-
threaded.  Additionally, do not under/over torque RF connectors, as this could result in 

unreliable results, or worse, damaging the IQC5000.  Always check manufacturer 
specification for proper torque ratings of all RF connectors. The table below defines the 

recommended torque ratings for RF connectors used within the IQC5000.
RF Connector Type Torque Rating (inch-pounds)

SMA 8.0

CAUTION
Marker and Trigger Input Voltage Should Not Exceed 5V

The operating range for the marker and trigger inputs is 1 to 3.3V DC.  The input voltage 
should not exceed 5V, as this could result in damage to the IQC5000.
10
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7. (Option) Connect the Time/Location Cables:
a. (Option: for time/location-tagging) Connect a NMEA GPS source to the NMEA GPS input on the 

IQC5000. See "NMEA GPS Port Baud Rate Selection" on page 48.
b. (Option: for precision time-tagging) Connect an IRIG-B122 source to the IRIG-B input on the IQC5000.

8. Power on the Units:
a. (Option: External Storage Units) Power on External Storage Unit 1 and External Storage Unit 2.

Note: Wait 15 seconds before continuing.
b. (IQC-MEM) Power on the MEM module.
c. Power on in any order:

 IQC5000

 Spectrum Analyzer

 Ethernet Switch

Note: If using PCIe offload, allow IQC to boot fully before powering on Computer Workstation.
d. Power on the Computer Workstation.
11
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Hardware Setup – Playback

The IQC5000B is capable of I/Q baseband and RF playback. The I/Q Baseband playback is intended for normal use, 
RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.

Figure 7   Playback Hardware Setup

To playback, perform the following steps:
1. Connect the Power Cables to the following devices:

a. IQC5000 (Note: requires 10-14V power adapter)
b. Ethernet Switch
c. Computer Workstation
d. IQC-MEM (Note: requires 10-14V power adapter)
e. (OPTION) External storage unit (s)

2. (Option: external storage) Connect cables for the IQC-MEM and external storage units.

a. Connect the External MiniSAS HD to External MiniSAS HD cable to  IQC5000B to MEM port – with tab 
facing down – connect remaining end to the IQC-MEM to IQC port – with tab facing up.

CAUTION
Use extra care when connecting External MiniSAS HD connectors, the ports are keyed,

but can be forced in upside-down.
12
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Figure 8   IQC-MEM Cable Connection

b. Connect one end of the External MiniSAS HD cable to the IQC-MEM EXT STORAGE PORT 1, connect the 
remaining end to External Storage Unit 1 data port.

Figure 9   IQC-MEM External Storage Cable Connections

c. (Option: 2-channel recording with ONE external SSD storage unit) Connect one end of the External 
MiniSAS HD cable to IQC-MEM EXT STORAGE PORT 2, and the remaining end of the cable to the Exter-
nal Storage Unit data port.

3. Connect Ethernet cables from the Ethernet Switch to the following:
a. IQC5000
b. Computer Workstation

4. Determine whether an I/Q baseband or fixed frequency playback is desired.
a. If I/Q baseband playback is desired go to Step 5.
b. If fixed frequency playback is desired go to Step 6.
13
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5. I/Q Baseband Playback through a Vector Signal Generator (VSG):
a. Connect the IQC5000 SMA analog I baseband output to the analog I baseband input on the VSG.
b. Connect the IQC5000 SMA analog Q baseband output to the analog Q baseband input on the VSG.
c. Connect an antenna or cable to the RF OUT of the VSG, and link it to the desired target.
d. Connect power cable to the VSG.
e. Power on the VSG.
f. Configure the VSG to mix the I/Q signal and modulate it to the desired frequency.

6. Fixed Frequency Playback from the IQC5000:
a. Connect the IQC5000 SMA RF output to the desired target.

7. Power on the Units:
a. (Option: External Storage Units) Power on External Storage Unit 1 and External Storage Unit 2.

Note: Wait 15 seconds before continuing.
b. Power on the MEM module.
c. Power on in any order:

 IQC5000

 Ethernet Switch

Note: If using PCIe offload, allow IQC to boot fully before powering on Computer Workstation.
d. Power on the Computer Workstation.

CAUTION
RF Connector Torque Ratings

When mating RF connectors, ensure that they are properly aligned and not cross-
threaded.  Additionally, do not under/over torque RF connectors, as this could result in 

unreliable results, or worse, damaging the IQC5000.  Always check manufacturer 
specification for proper torque ratings of all RF connectors. The table below defines the 

recommended torque ratings for RF connectors used within the IQC5000.
RF Connector Type Torque Rating (inch-pounds)

SMA 8.0
14
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Network Setup

The IQC5000 is a network-controlled device, negotiable on a 10/100/1000 Mbps connection.  The unit can be 
configured to a custom static IPv4 address and subnet mask. 

The IQC5000 is shipped with an IP address of 192.168.2.200 and a subnet mask of 255.255.255.0.  The IP address 
and  subnet mask can be changed by using IQC Control and following the instructions outlined in "Changing the 
IQC5000 IP Address" on page 48 and "Changing the IQC5000 Subnet Mask" on page 48.

Perform the following steps to set up networking with the IQC5000:
1. For any firewall devices that may limit network port usage, white list the ports/protocols in Table 7.

Table 7 - 

Device Type Vendor Device/Software Device Listening 
Port, Protocol

Record/Playback System Bird IQC5000 6644, TCP & UDP
Computer Workstation Bird IQC Control SCPI Command Server 6634, TCP & UDP

Spectrum Analyzer Keysight

N9010A/B

5025, TCP
N9020A/B
N9030A/B
N9040B

Spectrum Analyzer Rohde and Schwarz FSV/FSW 5025, TCP

Spectrum Analyzer Tektronix
RSA 5000 Series

4000, TCP
RSA 6000 Series

Spectrum Analyzer Anritsu MS2090A 9001, TCP
Auxiliary Software Rohde and Schwarz DigIConf 5026, TCP

Listening Ports and Protocols

2. Complete at least steps 1, 4, 5, 8c, and 8d of the Hardware Setup – Record Section.
3. If desired, change the IQC5000 network settings.

The IQC5000 is shipped with an IP address of 192.168.2.200 and a subnet mask of 255.255.255.0.  The IP 
address and  subnet mask can be changed by using IQC Control and following the instructions outlined in 
"Changing the IQC5000 IP Address" on page 48 and "Changing the IQC5000 Subnet Mask" on page 48.

4. Configure the Computer Workstation to have a static IP address in the subnet of 192.168.2.X where the last 
octet X is not the same as the IQC5000 IP address (and is also not equal to 1, 254, or 255), with a subnet mask of 
255.255.255.0.

5. Configure the Spectrum Analyzer with a static IP address in the subnet of 192.168.2.X where the last octet X is 
not the same as the IQC5000 or Workstation IP addresses (and is also not equal to 1, 254, or 255), with a subnet 
mask of 255.255.255.0.
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Keysight X-Series Spectrum Analyzer Setup

Note: Refer to the X-Series Operating Manual for more detailed instructions on signal analyzer opera-
tion.  The following represents the minimum steps required to perform a recording with the IQC5000.

Setting the IP Address

Setting the IP address on an X-Series spectrum analyzer follows the standard method of setting an IP address in 
Microsoft® Windows™.
Administrative Access
Before setting the IP address, you must gain administrative access.  To do so, follow these steps:
1. Log off user Instrument.
2. Log on as user administrator (no caps) with password Keysight4u! (agilent4u for Analyzers labeled Agilent).
3. Set the IP address as outlined in "Network Setup" on page 15.
4. Log off user administrator and log back on as user Instrument.

Turning on the SCPI Socket Server

The SCPI socket server must be running on the X-Series to record.  Follow these steps:
1. Press System on the front panel.
2. Press IO Config > SCPI LAN > SCPI Socket (Port 5025) On.

Figure 10   SCPI Socket Server

Hardware Alignment

Note: The alignment mode should not be set to automatic, else the I/Q streaming data is interrupted by an 
automatic calibration.  Alignment should be performed after a 20-minute warm-up, and immediately before 
recording for best results.

To set Hardware Alignment from Automatic to Manual:
1. Press System on the front panel.
Press Alignments > Auto Align > Off.
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Figure 11   Alignment Mode

Keysight Operation

The Keysight family of X-Series signal analyzers offer two different digital IQ streaming interfaces. One is for 
wideband streaming and one is for narrowband. The N9040B and N9030B provide up to 255 MHz of digital IQ 
streaming when equipped with options B2X or B5X, RTS and RT1 or RT2. They provide up to 160 MHz of digital IQ 
streaming when equipped with options B1X, RTS and RT1 or RT2. The wideband interface streams I and Q data via 
separate 50 pin LVDS connectors. Without option RTS, the N9040B and N9030B and the rest of the X-Series 
analyzers stream up to 40 MHz of IQ bandwidth through an 80 pin narrowband LVDS connector shown below, 
provided the signal analyzer is equipped with option B40.

Figure 12   Keysight N9030B Signal Analyzer Rear Panel

Each of the Keysight X-Series analyzers allow IQC Control to be run on the desktop of the signal analyzer. This has the 
benefit of eliminating the need for an external PC. The Keysight analyzers also include x4 PCIeGen2 interface 
allowing IQ data to be offloaded from the IQC5000B into the internal PC of the X-Series analyzer. 

Note: Optionally, an external USB 3.0 drive may be used to offload data to or from the analyzer
17
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Rohde and Schwarz FSV/FSW

Note: Refer to the FSV or FSW Operating Manual for more detailed instructions on signal analyzer opera-
tion.  The following represents the minimum steps required to perform a recording with the IQC5000.

Setting the IP Address

To set the IP address of the FSV/FSW:
1. Press Setup on the front panel.
2. Press Network + Remote.
3. In the IP Address field, enter the desired IP address, or alternatively select Open Dialog “Network Configuration” 

to bring up the Microsoft Network Configuration menu.
4. Set the IP address as outlined in "Network Setup" on page 15.

Configure Windows Firewall on the FSV/FSW to Allow DigIConf Traffic

The Windows Firewall needs to be configured on the FSV/FSW to allow DigIConf traffic from the Computer 
Workstation to the FSV/FSW.  To configure the firewall:
1. Navigate to Control Panel > Windows Firewall > Advanced Settings > Inbound Rules.
2. Select New Rule.
3. Select Port and click Next.
4. Select to apply this rule to TCP traffic on specific local port 5026 and click Next.
5. Select Allow the Connection and click Next.
6. Select to apply this rule to Domain, Public, and Private interfaces and click Next.
7. Name the rule DigIConf and click Finish.

(Optional) Running DigIConf on Another Machine

DigIConf software by default is set to run on the FSV/FSW, so that the IQC5000 system can interface with the EX-IQ 
(this default setup is highly recommended).  If desired, DigIConf may be installed on a workstation, and the EX-IQ 
may be attached to and controlled by that workstation.  The following instructions detail how to configure DigIConf 
on a workstation. 
Installing DigIConf
To install the DigIConf software, run the installer included on the EX-IQ software disc.  You will be prompted to 
accept the End-User License Agreement, as well as to accept the installation of various drivers.  The DigIConf 
software must be version 03.01.009.30 or higher.
Running DigIConf
Ensure the hardware is connected according to the steps outlined in "Hardware Setup – Record" on page 8 with the 
exception of the EX-IQ connected via USB to the desired workstation. Once the hardware setup is complete:
1. Start the DigIConf software.
2. Start IQC Control and add a remote device for the FSV/FSW.
3. Set the IP address for DigIConf within the remote device menu to the IP address of the workstation.  Use the 

loopback address of 127.0.0.1 if running locally.  (See "Connecting/Disconnecting to a Remote Device" on 
page 50 and "Managing Remote Devices" on page 51 for more details.)

The Setup Diagram shown in the program menu should reflect the hardware setup:
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Figure 13   DigIConf Setup Diagram

No further configuration of DigIConf is required.  The IQC Control software will automatically configure the rest.
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Tektronix RSA6000 Series

Note: Refer to the Tektronix RSA6000B Operating Manual for more detailed instructions. The following 
steps are intended to provide a quick setup of record-specific settings.

It is recommended that a saved setup be made after completing the necessary steps for recording.  A saved setup 
file can be set to a user preset, so that the setup can be quickly recalled.

Note: Settings in the Config In/Out menu on the RSA are not reset by a preset. These settings will need to 
be checked after recalling a saved setup.

Save a Setup

To save a setup as a user preset on the RSA:
1. Go to File > Save As…
2. Navigate to C:\RSA6100B Files\User Presets and select to save as type Setup file.
3. Go to Tools > Settings > Presets, and then select User from the drop-down Preset type. See Figure 14.
4. The new preset should show in the preset listing.  If it is not at the top of the list, select it and then press the Up 

button on the right of the list to move it to the top.
5. Select Recall selected preset from the drop-down Preset action.

Figure 14   Tektronix Presets

The preset can now be activated any time by pressing the User button on the front panel, in the Presets block.
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Connection Points

This section describes the input and output connectors on the Tektronix RSA6000 spectrum analyzer.  For more 
information on the spectrum analyzer, reference the Tektronix RSA Operating Manual.

Figure 15   Tektronix RSA Front Panel

The following is a description of the front-panel controls on the RSA.

Table 8 - 
Item Label Description

1 Trig Out Trigger output connector. 50 Ohm, BNC, High > 2.0 V, Low < 0.4 V

2 Trig In External Trigger input connector, –2.5 V to +2.5 V range

3 USB Ports USB 2.0 connector

4 RF Input RF input connector 50 Ohm, +30 dBm input maximum

Tektronix RSA Front Panel Connectors
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Figure 16   Tektronix RSA Rear Panel

The following is a description of the rear-panel connection points on the RSA.

Table 9 - 
Item Description

1 AC Input, main power connector

2 GPIB

3 PS2 Keyboard input

4 Real Time IQ Out (Option 05)

5 Microphone in; Headphone, audio output; and Line In connectors

6 External Trigger 2 Input

7 Ref In, reference frequency input

8 Ref Out, reference frequency output

9 COM 2, serial port for connecting peripherals

10 VGA external monitor output (resolution not limited to VGA)

11 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)

12 LAN, Ethernet network connector

13 +28 VDC output, switched

Tektronix RSA Rear Panel Connectors
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Setting the IP Address

Setting the IP address on the RSA follows the standard method of setting an IP address in Microsoft® Windows 
Vista™ or Microsoft® Windows 7™, depending on the operating system installed on the RSA.
Set the IP address as outlined in "Network Setup" on page 15.

Turning On the SCPI Socket Server

The SCPI socket server must be running on the RSA for recording.  Follow these steps:

1. Right-click on the TekVISA LAN Server Control icon in the system tray: 

2. Select Server Status from the menu that appears:

Figure 17   TekVisa Server Control Menu

3. Click the Start Socket Server button in the upper-right corner.
4. To start the socket server during power-on of the RSA, click Server Properties as seen in Figure 17.  Next, under 

the Socket Server section, click the check box Start server at system powerup (see Figure 18):

Figure 18   TekVisa LAN Server Properties

Hardware Alignment

Note: The alignment mode should not be set to automatic, else the I/Q streaming data is interrupted by an 
automatic calibration.  Alignment should be performed after a 20-minute warm-up, and immediately before 
recording for best results.

To set Hardware Alignment from Automatic to Manual:
1. Go to Tools > Alignments.
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2. Select the Run alignments only when “Align Now” button is pressed option. 
3. Select Align Now to perform alignment.

Figure 19   Alignments Dialog Box

Enable DPX  Display

The DPX display must be enabled to record data from the RSA. It is recommended that only the DPX display is 
enabled during recording to minimize processing conflict.  To enable the DPX display:
1. Press the Displays button on the front of the RSA.

Figure 20   Tektronix Select Displays Dialog Box

2. Verify that General Signal Viewing is selected under Folders.
3. Double-click DPX under Available Displays.
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Anritsu Field Master Pro MS2090A

Refer to the Anritsu Field Master Pro MS2090A User Guide for detailed instructions on setup and configuration of 
the MS2090A. 
The control software for the IQC5000B, IQC Control, controls the IQ streaming operation via the Ethernet 
connection to the MS2090A. 
The MS2090A Data Out and USB ports connect to the MA25424A Data In and USB ports (note that the USB port is 
used for power and this could come from any external USB 3.0 power supply capable of supplying ~4 W).
The MA25424A splits the I and Q signal components to the two respective I and Q output ports (IEEE 1284-C) and 
streams the data to the IQC5000B I and Q input ports.

Figure 21   Anritsu Connection Diagram
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Starting and Stopping the System

Some of the devices within the IQC5000 system setup must be connected and powered on and off in a certain 
order.  All steps that must be performed in a particular order are noted below:

Note: When using the PCIe cable connection between the IQC5000 and the Computer Workstation, the 
IQC5000 must be powered on before the Computer Workstation is powered on, and it must be powered off 
after the Computer Workstation is powered off.  PCIe is generally not plug-and-play – a crash of the Micro-
soft® Windows™ OS on the Computer Workstation may occur if the IQC5000 is powered off while connected 
to it via PCIe.
Note: When using IQC- MEM, there is a specific order for powering on the systems (after all connections 
have been made) that must be observed.  First, power on the external storage unit (s) and wait 15 seconds. 
Next, turn on the IQC-MEM module.  Lastly, turn on the IQC5000.

The Ethernet Switch, Spectrum Analyzer and peripherals may all be turned off or restarted when not recording or 
playing back.
When the Power button is pressed on the front of the IQC5000, a blue LED will light and the front panel will display 
Loading.  The IQC5000 will take approximately 10 seconds to initialize.  When it is ready, it will display IQC5000 
System Ready.
Follow the instructions in Chapter 2, Setup to power on the system

 Recording Power On: Step 8 on page 11.
 Playback Power On: Step 7 on page 14.

To power off the system, simply follow the power-on steps in reverse.

Using the IQC5000 Front Panel

Only select settings are exposed for configuration using the front panel. For full control of the IQC5000, use the IQC 
Control software. See "Using IQC5000 with IQC Control" on page 37. 

Viewing the NIC Parameters

Perform the following steps to view the Network Interface Card parameters of the IQC5000:
1. Press the Menu button.
2. Press the right arrow button until NIC Parameters shows on the front panel display.
3. Press the down arrow to scroll through the NIC parameters.
The NIC parameters of the IQC5000 include:

 IP Address – the IP address of the IQC5000, settable via IQC Control (see "Changing the IQC5000 IP 
Address" on page 48).

 UDP Port number – the port number used to communicate with the IQC5000.

 Subnet Mask –the subnet mask of the IQC5000, settable via IQC Control (see "Changing the IQC5000 Sub-
net Mask" on page 48).

 Gateway – the default gateway of the IQC5000.
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 Instrument IP Address – the IP address of the spectrum analyzer connected to the IQC5000, settable via IQC 
Control (see "Adding a Remote Device" on page 49).

 Instrument Port Number – the port number of the spectrum analyzer connected to the IQC5000, settable 
via IQC Control (see "Adding a Remote Device" on page 49).

Setting the Sample Rate Selection

Certain processes are optimized for recording using a sample rate greater than 120MHz with the Tektronix 
RSA6000.  To set the sample rate mode:
1. Press the Menu button.
2. Press the right arrow button until Sample Rate Select shows on the front panel display.
3. Press the down arrow until the sample rate selections show:

a. 120MHz OR GREATER
b. LESS THAN 120MHz

4. Press the Select button to choose the appropriate sample rate mode.

Operational Overview

The IQC5000 records and plays back RF signals.
The following devices are used for recording and playback:

 IQC5000: The main system controller during record/playback. Starts and stops record/playback, marks data 
with time/location, writes data to storage during recording, converts digital data to analog I/Q and RF 
during playback.

 Spectrum Analyzer: Digitizes the RF data and streams it to the IQC5000. Also used to graphically view the RF 
spectrum in real-time or near real-time.

 Storage Media/Controllers
o IQC5000B-MEM Module: The IQC-MEM is a storage controller capable of writing to internal removable 

SSD RAID storage units, or to external RAID0 storage units. 
o External Storage: Enclosure containing disk drives formatted with industry-standard RAID0 striping to 

increase write speed.
 Computer Workstation: Used to control the IQC5000 through the IQC Control software or API. Also pro-

vides the destination for offloaded data.
 Ethernet Switch: Provides network interconnection for IQC5000, Spectrum Analyzer, and Workstation.

 Vector Signal Generator: Converts analog baseband I/Q from the IQC5000 to RF during playback. Necessary 
if an arbitrary center frequency or other RF functions are desired.

 IRIG/GPS Source(s): Provide(s) time and location data for markers during recording.

See Chapter 2 "Setup" on page 8 for instructions on setting up the IQC5000 to record or playback.
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Controlling the IQC5000

The IQC5000 can be controlled in two possible ways:

 IQC Control Software User Interface: IQC Control Software on the Computer Workstation is the primary 
method of control for the IQC5000. See "Using IQC5000 with IQC Control" on page 37. 

 Command Server/API: A network sockets server runs in the background while IQC Control is running, and 
can be used to programmatically interface with the IQC5000 and connected devices using a SCPI-like lan-
guage. See the IQC5000 API Programming Manual.

Record (Capture, Acquisition)

IQC5000B Storage
The IQC5000B-MEM module supports reading/writing to external storage as well as reading/writing to internal, 
removable drive cartridges.

Table 10 - 
IQC5000B IQC-MEM

Internal 
SSD Drives

External
SSD Drives

Storage Medium One or two removable drive cartridges 1 externally connected enclosure, with 16 
drives

Memory Depth 
Configurations 2000 GB each 8TB or 15TB enclosure

Max Number of Files 1018

Supported Data Rates Up to 800 MB/s per cartridge Up to 1600 MB/s

Supported # of Record/
Playback Channels

One with one cartridge installed
OR
one or two with two cartridges installed

One or two †

†. Two channel recording with external SSD storage enclosures requires using two MiniSAS cables to connect the main 
enclosure to the IQC5000B-MEM

File System ext4

Volume Format mdadm RAID0

IQC5000B-MEM Supported Storage Options
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Steps to Record

The high-level steps to record with the IQC5000 are:
1. Set up the hardware - follow steps in "Hardware Setup – Record" on page 8.
2. Set up the network - follow steps in "Network Setup" on page 15.
3. Set up the spectrum analyzer - follow steps in Spectrum Analyzer setup for your spectrum analyzer type.
4. Identify signal of interest on spectrum analyzer.
5. Set up the desired record method - follow one of the choices below:

 User Interface - follow steps in "Recording with IQC Control" on page 53.

 Command Server/API – see the IQC5000 API Programming Manual.
6. Modify center frequency, input power settings, and acquisition bandwidth.
7. Record.

Record Equations

The following equations are calculated by the IQC Control UI and API, and are listed here for reference:
Calculate Remaining Record Time Available
To calculate the remaining length of time available for a recording (in seconds), take the remaining storage in bytes 
and divide by the data rate in bytes/second for the corresponding spectrum analyzer acquisition bandwidth.  See 
"Acquisition Bandwidth" on page 30.
Remaining Record Time (s) =
Storage Remaining (bytes) ÷ Data Rate for Acq BW (bytes/second)
Calculate Recording File Length of Time
The same formula applies for calculating the length in time of a recording:
Recording File Length of Time (s) =
File Length (bytes) ÷ Data Rate for Acq BW (bytes/second)

Record Start/Stop Methods

Using the IQC Control software UI or API, the following recording start/stop methods are available.

Table 11 - 
Record Type Start Stop

Basic
Manual Immediate (Manual) Immediate (Manual)

Duration Immediate (Manual) Duration

Advanced – any combination of start/stop methods is 
possible

Immediate (Manual) Immediate (Manual)

Time of Day Time of Day

Trigger Trigger

Duration

Record Start and Stop Methods
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Following is a brief description of the possible record start/stop methods:

 Immediate (Manual) (start and/or stop) – starts/stops a recording immediately on user input.
 Time of day (start and/or stop) – starts/stops a recording at a specified time of day.

 Trigger (start and/or stop) – starts/stops a recording based on trigger parameters.
o 2 TTL-level trigger inputs
o Rising or Falling edge

 Duration (stop only) – records for a specified duration of time or samples

Acquisition Bandwidth

The Acquisition Bandwidth, Recording Bandwidth, or Recording Span all refer to the instantaneous bandwidth that 
will be recorded. With a center frequency at 400 MHz, a 10 MHz acquisition bandwidth would record all signals ± 5 
MHz from 400 MHz (395 to 405 MHz).
Keysight and Rohde & Schwarz recordings are capable of arbitrary acquisition bandwidths below their max 
supported span, down to 19.531kHz. Tektronix RSA and Anritsu Field Master Pro recordings are set to discrete 
acquisition bandwidths according to set sample rates.

Table 12 - Tektronix RSA6000 Discrete Acquisition Bandwidths Supported by the IQC5000
I/Q Sampling 

Rate (Sps)
Data Rate 
(Bytes/s)

RSA6000 Acq 
BW (Hz)

SR/Acq BW 
Divisor

Highest Option 
Required

150,000,000 600,000,000 110,000,000 1.3636 110, 05

75,000,000 300,000,000 60,000,000 1.2500 110, 05

50,000,000 200,000,000 40,000,000 1.2500 05

25,000,000 100,000,000 20,000,000 1.2500 05

12,500,000 50,000,000 10,000,000 1.2500 05

6,250,000 25,000,000 5,000,000 1.2500 05

3,125,000 12,500,000 2,500,000 1.2500 05

1,562,500 6,250,000 1,250,000 1.2480 05

781,250 3,125,000 625,000 1.2500 05

390,625 1,562,500 312,500 1.2500 05

195,312.5 781,250 156,250 1.2500 05

97,656.25 390,625 78,125 1.2501 05

48,828.125 195,313 39,062 1.2501 05

24,414.0625 97,656.25 19,531 1.2499 05
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Table 13 - Tektronix RSA5000B Discrete Acquisition Bandwidths Supported by the IQC5000
I/Q Sampling 

Rate (Sps)
Data Rate 
(Bytes/s)

RSA5000B Acq 
BW (Hz)

SR/Acq BW 
Divisor

Highest Option 
Required

200,000,000 800,000,000 165,000,000 1.2121 B16X or B16XHD

200,000,000 800,000,000 85,000,000 2.3529 B85 or B85HD Only

100,000,000 400,000,000 80,000,000 1.2500 B85 or B85HD

50,000,000 200,000,000 40,000,000 1.2500 B40

25,000,000 100,000,000 20,000,000 1.2500 B25

12,500,000 50,000,000 10,000,000 1.2500 B25

6,250,000 25,000,000 5,000,000 1.2500 B25

3,125,000 12,500,000 2,500,000 1.2500 B25

1,562,500 6,250,000 1,250,000 1.2500 B25

781,250 3,125,000 625,000 1.2500 B25

390,625 1,562,500 312,500 1.2500 B25

195,312.5 781,250 156,250 1.2500 B25

97,656.25 390,625 78,125 1.2500 B25

48,828.125 195,313 39,062 1.2500 B25

24,414.0625 97,656.25 19,531 1.2500 B25

Table 14 - Tektronix RSA5000A Discrete Acquisition Bandwidths Supported by the IQC5000
I/Q Sampling 

Rate (Sps)
Data Rate 
(Bytes/s)

RSA5000A Acq BW 
(Hz)

SR/Acq BW 
Divisor

Highest Option 
Required

150,000,000 600,000,000 165,000,000 (Opt. 110) 
85,000,000 (Opt. 85)

1.3636 (Opt. 110) 
1.7647 (Opt. 85)

110 (Opt. 110) or
85 (Opt. 85)

75,000,000 300,000,000 60,000,000 1.2500 110 or 85

37,500,000 150,000,000 30,000,000 1.2500 110 or 85

50,000,000 200,000,000 25,000,000 2.0000 25

25,000,000 100,000,000 20,000,000 1.2500 25

12,500,000 50,000,000 10,000,000 1.2500 25

6,250,000 25,000,000 5,000,000 1.2500 25

3,125,000 12,500,000 2,500,000 1.2500 25

1,562,500 6,250,000 1,250,000 1.2500 25

781,250 3,125,000 625,000 1.2500 25

390,625 1,562,500 312,500 1.2500 25

195,312.5 781,250 156,250 1.2500 25

97,656.25 390,625 78,125 1.2500 25

48,828.125 195,313 39,062 1.2500 25

24,414.0625 97,656.25 19,531 1.2500 25
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Table 15 - Anritsu MS2090A Acquisition Bandwidths Supported by the IQC5000

I/Q Sampling 
Rate (Sps)

Data Rate 
(Bytes/s)

MS2090A 
Acq BW (Hz)

SR/Acq BW 
Divisor

Highest Option Required

Spectrum 
Analyzer Mode

Real Time 
Spectrum 

Analyzer Mode

200000000 800000000 110000000 1.818181818 Option 104 Option 199 and 
Option 104

122880000 491520000 100000000 1.2288 Option 104

100000000 400000000 80000000 1.25 Option 104 Option 199 and 
Option 104

92160000 368640000 74000000 1.245405405 Option 104

61440000 245760000 50000000 1.2288 Option 103

50000000 200000000 40000000 1.25 Option 103 Option 199 and 
Option 103

46080000 184320000 36000000 1.28 Option 103

30720000 122880000 25000000 1.2288 Option 103

25000000 100000000 20000000 1.25 None Option 199

23040000 92160000 18000000 1.28 None

15360000 61440000 12000000 1.28 None

12500000 50000000 10000000 1.25 None Option 199

7680000 30720000 6000000 1.28 None

6250000 25000000 5000000 1.25 None Option 199

3840000 15360000 3000000 1.28 None

3125000 12500000 2500000 1.25 None Option 199

1920000 7680000 1500000 1.28 None

1562500 6250000 1250000 1.25 None Option 199

360000 1440000 280000 1.285714286 None

45000 180000 36000 1.25 None
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Playback

The IQC5000B is capable of I/Q baseband and RF playback. The I/Q Baseband playback is intended for normal use, 
RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.
The IQC5000 is capable of playing back 2 channels of analog I/Q baseband waveforms, and 1 channel at RF.  Using 
the IQC Control software, the following playback options are available:

 Partial file playback
 Looped file playback
 RF fixed frequency playback at 2.4GHz
 Analog I/Q Playback

Steps to Playback

The high-level steps to playback with the IQC5000 are:
1. Set up the hardware - follow steps in "Hardware Setup – Playback" on page 12
2. Set up the RF target (VSG, spectrum analyzer, system under test, etc.)
3. Set up the desired playback method - follow one of the choices below:

 User Interface - follow steps in "Playback with IQC Control" on page 58.
 Command Server/API – see the IQC5000 API Programming Manual

4. Playback

IQC5000 Supported Playback Acquisition Bandwidths

Select discrete acquisition bandwidths are supported for playback.  If playback of a recording is desired, it is 
recommended to record at a playback-supported acquisition bandwidth.

Table 16 - IQC5000 Supported Playback Acquisition Bandwidth- Keysight

I/Q Sampling Rate 
(Sps)

Data Rate 
(Bytes/s)

Keysight 
Recording Spans (Hz)

X-series
with
RTS 

Option

X-series
without

RTS 
Option

300,000,000 down to 
31,250,000 in any step 
supported by the signal 

analyzer

4x IQ 
Sampling 

Rate

255,000,000 
down to 

24,949,188

40,000,000 
down to 

25,000,000

25,000,000 100,000,000 20,000,000 20,000,000

12,500,000 50,000,000 10,000,000 10,000,000

6,250,000 25,000,000 5,000,000 5,000,000

3,125,000 12,500,000 2,500,000 2,500,000

1,562,500 6,250,000 1,250,000 1,250,000

781,250 3,125,000 625,000 625,000
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Table 17 - IQC5000 Supported Playback Acquisition Bandwidth- Rohde & Schwarz

I/Q Sampling Rate 
(Sps)

Data Rate 
(Bytes/s)

Rohde & Schwarz 
Recording Spans (Hz)

FSV/
FSVR FSW

300,000,000 down to 
31,250,000 in any step 
supported by the signal 

analyzer

4x IQ 
Sampling 

Rate

40,000,000 
down to 

25,000,000

160,000,000 
down to 

25,000,000

25,000,000 100,000,000 20,000,000 20,000,000

12,500,000 50,000,000 10,000,000 10,000,000

6,250,000 25,000,000 5,000,000 5,000,000

3,125,000 12,500,000 2,500,000 2,500,000

1,562,500 6,250,000 1,250,000 1,250,000

781,250 3,125,000 625,000 625,000

Table 18 - IQC5000 Supported Playback Acquisition Bandwidth- Tektronix

I/Q Sampling Rate 
(Sps)

Data Rate 
(Bytes/s)

Tektronix 
Recording Spans (Hz)

RSA6000 RSA5000A RSA5000B 

300,000,000 down to 
31,250,000 in any step 
supported by the signal 

analyzer

4x IQ 
Sampling 

Rate

110,000,000 
down to 

25,000,000

110,000,000 
down to 

25,000,000

165,000,000 
down to 

25,000,000

25,000,000 100,000,000 20,000,000 20,000,000 20,000,000

12,500,000 50,000,000 10,000,000 10,000,000 10,000,000

6,250,000 25,000,000 5,000,000 5,000,000 5,000,000

3,125,000 12,500,000 2,500,000 2,000,000 2,500,000

1,562,500 6,250,000 1,250,000 1,000,000 1,250,000

781,250 3,125,000 625,000 500,000 625,000
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Table 19 - IQC5000 Supported Playback Acquisition Bandwidth- Anritsu

I/Q Sampling Rate 
(Sps)

Data Rate 
(Bytes/s)

Anritsu 
Recording Spans 

(Hz)

200,000,000 down to 
31,250,000 in any strip 

supported but the spectrum 
analyzer

4x IQ Sampling 
Rate

110,000,000 down to 
25,000,000

25,000,000 100,000,000 20,000,000

23,040,000 92,160,000 18,000,000

15,360,000 61,440,000 12,000,000

12,500,000 50,000,000 10,000,000

7,680,000 30,720,000 6,000,000

6,250,000 25,000,000 5,000,000

3,840,000 15,360,000 3,000,000

3,125,000 12,500,000 2,500,000

1,920,000 7,680,000 1,500,000

1,562,500 6,250,000 1,250,000

Markers

The IQC5000 supports time- and location-stamping recordings, using markers to correlate the time and location 
(location is only available if GPS is connected and valid) to a specific sample in the recording.  A time (and location, if 
GPS is connected and valid) will automatically be assigned to the beginning and end of the recording.
To mark data, attach a TTL-level trigger source to the Marker 1 or Marker 2 inputs on the rear of the IQC5000; 
alternatively, press the MARK button on the front panel of the IQC5000.  A marker will be placed in the recording’s 
.xmrk file that will correspond to the time/location and sample point on the trigger rising edge, falling edge, or both 
– this is configurable in IQC Control (see "Setting up Markers" on page 56) and the API.  The re-arm time for markers 
is 1ms; the marker rate is effectively 1,000 markers per second. See The "The xmrk Marker File" on page 67 for 
information about the marker file format.

Timing

The IQC5000 follows a hierarchy when choosing which time source to use:

Table 20 - IQC5000 Timing Hierarchy
Priority Time Source Description

1 IRIG-B Most precise method of time-stamping

2 NMEA-GPS If IRIG-B signal is not present, use NMEA time if attached and valid

3 Workstation Time Used for IQC Control software UI or API recordings only, if IRIG-B or 
NMEA GPS signals are not present

Note: An external time source must be used when using Time of Day record triggers.
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NMEA Data
The IQC5000 supports the following NMEA-formatted data input:

Table 21 - IQC5000 NMEA Data Input
Connectors DB-9 (with optional 1 pulse per second signal connected to Marker 1 SMA input)

See Figure 22.

NMEA 
Sentences

GPGGA
GPVTG
GPZDA

Protocol 
Standard

RS-232

Figure 22   NMEA Data Input

NMEA custom cables are available from Bird.  The 1PPS signal may be optionally connected to the Marker 1 SMA 
port to insert a marker every second.
The baud rate for the NMEA GRPS input (DB9) is selectable. See"NMEA GPS Port Baud Rate Selection" on page 48.

File Transfer

There are 2 supported methods of transferring data between the IQC5000 storage and the Computer Workstation 
storage:

 PCIe – The fastest way to offload data.  Requires the use of a PCIe cable.  Offload speeds up to 450MB/s are 
possible if offload destination supports writing at that speed.  Connect the PCIe cable between the IQC-
MEM module and the Computer Workstation.  See "Setup" on page 8 for more information.

 Ethernet – The slowest way to offload data.  Requires no additional cables.
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Chapter 4 Using IQC5000 with IQC Control

The IQC5000 is controlled through IQC Control.  An API is available for controlling the IQC5000, and is detailed in the 
IQC5000 API Programming Manual.  The following sections detail IQC Control’s Graphical User Interface.

Installing the IQC Control Software and Loading the IQC5000 Firmware

On the IQC5000 software CD shipped with the product, access the file IQC5000_setup_vW.X.Y.ZZZ.exe, where 
W.X.Y.ZZZ represents the version number of the installer.  This software and firmware installer installs the IQC 
Control software, and also updates the firmware on an IQC5000 over Ethernet. The IQC5000 firmware can only be 
updated if it is powered on and networked to the PC running the installer.  Note that if the firmware on more than 
one IQC5000 system is being updated at any given time, it is important to ensure that each IQC5000 has a different 
IP address.
The following software is required to run IQC Control:

 Microsoft® Windows 7™ 64-bit or Windows 8™ 64-bit
 Microsoft® Visual C++ 2013 x64 Redistributable Package (included in IQC Control installation)
 Microsoft® .NET Framework 4.5.2 or later

Install the IQC Control software and load IQC5000 firmware

1. Determine the IP address of your IQC5000:
a. Verify that the IQC5000 is powered on and connected to the network.  It is highly recommended to use 

a hard-wired Ethernet connection on a network with minimal network traffic while updating.
b. Press the MENU button on the front panel of the IQC5000.
c. Navigate to NIC Parameters through the menu items using the left and right arrow keys.
d. Press the down arrow key until IP Address is selected.
e. The IQC5000 IP Address is shown – make note, as it will be used in later steps.

2. Completely power off the IQC5000 system. If IQC-MEM is being used, follow the proper power-off sequence, as 
described in "Starting and Stopping the System" on page 26.

3. If IQC-MEM is being used and cabled to the IQC5000, leave the external storage units powered off, then power 
on the IQC-MEM unit and allow it to boot for 30 seconds.

4. Power on the IQC5000. Once the front panel displays SYSTEM READY, continue with Step 5. 
Note: Wait until front panel displays SYSTEM READY, before continuing to Step 5.

5. Run the installer IQC5000_setup_vW.X.Y.ZZZ.exe.
6. Click Next. See Figure 23 on page 38.
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Figure 23   IQC Control Setup Wizard

7. Choose the installation directory and then click Install.

Figure 24   IQC Control Directory Selection

8. The firmware update message box will display:
a. Enter the IP address of your IQC5000 in the IP Address text box and click the Connect button.

Alternatively, if the device has previously been added as a tab in IQC Control select the device from 
the list at the bottom of the window.
If there is an issue connecting, a message box will display. See “Connecting to the IQC5000” on 
page 45 for details on troubleshooting connection issues. 

Note: Some configuration options, such as selecting Single or Dual RAIDS, must be selected during a 
firmware update. For more information on advanced features. See “Firmware Configuration Updates” on 
page 82.

b. System defaults to Single RAID configuration. If Dual RAID operation is desired, perform the following:
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i. Once the IQC5000 unit has been detected, select Advanced in the lower right corner of the IQC 
5000 FW Installer dialog box. See Figure 26.
ii. In the MEM/RIF FW Override field, enter one of the following codes. See Figure 25.

 SINGLE - enter this code to switch from Dual RAID mode to Single RAID mode.

 DUAL - enter this code to switch from Single RAID mode to Dual RAID mode.

Note: The codes must be entered in all caps, with no spaces or extra characters.

Figure 25   Advanced Settings Selection Dialog

ii. Click Save.
c. Verify the IQC5000 details are correct and click Configure and run an update.

d. Firmware that has been detected as requiring an update will be pre-selected.   Click Commence 
Update. The progress of the firmware installation is displayed. 
Note: It is not recommended to manually overwrite firmware unless instructed to do so by Bird support.

CAUTION
Disconnecting power from the IQC5000 during the firmware upgrade process could result

in permanently disabling some features of the IQC5000 system.
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Figure 26   IQC5000 Firmware Update Sequence

e. After the firmware installation process has finished, click OK to close the firmware installation.
f. Power off the IQC5000:

i. If IQC-MEM is being used, the IQC-MEM module should be powered off first.
ii. Power off the IQC5000.

g. If IQC-MEM is being used with external storage units:
i. Power on the external storage units and allow it to boot for 30 seconds.
ii. Power on the IQC-MEM module and allow it to boot for 30 seconds.

h. Power on the IQC5000.
9. Click Finish to close the installer.
10. Restart the Computer Workstation.
The IQC Control software has been installed and the IQC5000 firmware has been updated. The IQC5000 is now ready 
to use.
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Installing the PCIe Driver

With all of the equipment powered down, ensure the Ethernet and PCIe connections are made as described in 
Chapter 2 "Setup" on page 8. 
To install or update the PCIe driver:
1. Power on the control computer or real time spectrum analyzer where IQC Control is or will be installed, but 

leave the IQC and MEM(s) powered off. 
Note: IQC and MEM(s) units should remain powered off until IQC_PCIe installer is completed.

2. Install the driver with the IQC_PCIe_setup.exe installer. 
This will first uninstall the old PLDA PCIe driver and any previous version of the existing driver on the machine 
and then install the new PCIe driver. 

3. After the installer is complete, IQC_PCIe should be shown in the Windows Device Manager, device tree, see 
Figure 27.

Figure 27   Windows Device Manager — Multifunction Adapters 

4. Apply power to the complete IQC System and other attached equipment in the recommended order. See step 7. 
“Power on the Units:” on page 14.

5. When the IQC System powers up, Windows will most likely popup the "Installing device driver software" bubble 
(see Figure 28).  When this opens, Windows is searching "Windows Update" for the most recent driver for the 
IQC PCIe link.  If you click on the bubble, Windows will open the Driver Software Installation dialog.

Figure 28   Windows Driver Installation

6. When Driver Software Installation is complete, a second IQC device can be found in the Windows Device Man-
ger Tree under Multifunction adapters to verify successful installation and device detection. See Figure 29.

Figure 29   Windows Device Manager — Multifunction Adapters 
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Starting IQC Control

Shortcuts on the desktop and Start menu are created when IQC Control is installed.
To access the Start menu shortcut, navigate to Start > All Programs > X-COM > X-COM Control > X-COM Control. 

Adding an IQC5000 to IQC Control

The IQC5000 is added as a device in IQC Control and can be accessed as a tab on the main user interface or in a 
separate window.
1. Start IQC Control.
2. Select Tools > Add Control Tab.  The Add Control Tab menu appears. 

Figure 30   Adding an IQC5000 to IQC Control

3. Select the device type from the supported device list. For IQC-MEM, select MEM/RIF.

Figure 31   Add Control Tab Dialog Box

4. Select Network Controlled and enter the IP address of the device.  A red X  or green check mark  shows 
whether the IP address is of acceptable format.  (For information on PCI Controlled mode, see "File Transfer 
Methods" on page 61.)

5. (Optional) Enter a descriptive identifier for the device by de-selecting the Generate Identifier check box and 
entering your own text.  If the check box is left checked, an identifier string will be created from the device type 
and IP address.

6. Press Add. 
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The IQC5000 Control Tab Layout and Visual Components

The IQC5000 control tab can be broken down into 3 main sections (See “IQC5000 Control Tab” on page 43):

 IQC5000 Management – at the top left of the tab, this pane manages recording, playback, marker, and trig-
ger parameters.

 File Management – at the bottom of the tab, this pane shows all recorded files.
 Remote Device Management – at the right of the tab, this pane manages peripheral devices (including the 

spectrum analyzer and other auxiliary devices).

Figure 32   IQC5000 Control Tab

System, Record, Playback Tabs

The System, Record, and Playback Tabs are used to configure system operation.

Figure 33   System, Record, and Playback Tabs

 System tab is used to select and configure RAIDs, set maximum record file size, set NMEA GPS baud rate, 
and monitor system temperatures. See “Managing IQC5000B-MEM External Storage” on page 46.

 Record tab is used to select input channels, enable marker inputs, select recording type and view presence 
of external input signals. See “Recording with IQC Control” on page 53.

 Playback tab is used to select playback channels, output type, and start and stop times. See “Playback with 
IQC Control” on page 58.
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Progress Bar

The progress bar is located near the top of the IQC5000 Management section.  It displays the state of the IQC5000 – 
such as Idle when it is not performing any action – and the progress of the current operation (such as record, 
playback, or erase).  In certain situations, such as for recordings waiting for a stop trigger, the progress bar will show 
that it is recording with no respect to time.  Manual recordings show the progress in respect to how much memory 
is left.

Indicators

The IQC5000 system takes on the role of a hub for many signals and operations, and for this reason, 
indicators are used heavily within the user interface.  Simple circles that light green or red indicate the 
presence or the readiness of a specific component.  The Recording Channel indicators are unique and are 
covered in "Channel Selection" on page 54.

VU Meter

The VU Meter is located at the left side of the IQC5000 Management section.  There are 2 bars – the left 
corresponds to the Channel 1 recording, and the right to the Channel 2 recording.

 The VU Meter graphically represents the maximum digitized value in relation to the dynamic range of the 
digitizer.  After the refresh time of 300ms, the VU Meter is updated to reflect the maximum value detected 
during that 300ms.  This is a maximum value hold operation, rather than averaging the value. 
It is important not to under-range or over-range (clip), but effectively utilize the maximum dynamic range 
of the digitizer.  For example, the importance is the same as recording a human voice with a microphone at 
a gain level suited for a whisper, or for shouting, depending on the expected performance’s volume level.

Table 22 - VU Meter Color Gradient
Percentage of Digitizer 

Max Value

Color Linear Logarithmic

Red 85.1 - 100% 97.6 - 100%

Orange 75.1 - 85% 93.6 - 97.5%

Yellow 65.1 - 75% 90.1 - 93.5%

Green 0 - 65% 0 - 90%

There are two modes – linear and logarithmic – selectable by right-clicking the VU Meter.  Linear mode displays the 
ratio of the digitized value to the dynamic range of the digitizer in bits, linearly.  Logarithmic mode displays the 
maximum value in terms of power, logarithmically.
Ideally, the recording should be made as close to the maximum level as possible, considering the possible change in 
signal amplitude that may result in over-ranging.  Therefore, it is recommended that the recording be made as close 
to the linear 85% level, where the VU Meter changes from orange to red.  If a known signal of constant amplitude is 
being recorded, this level can be pushed further to the 90 - 95% level.
The maximum value detected during a recording is saved to the recording’s header file. 
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Connecting to the IQC5000

Establishing Connection

Press the Connect button to connect to the IQC5000. 

Figure 34   IQC5000 Connection

Establishing the connection triggers a quick and simple automated process that runs through a series of verification 
procedures in order to ensure optimal device connectivity and operation.  Connections to any previously used 
remote devices are also established as part of this routine.
Once the device is connected, the Connect toggle button will change to Disconnect, and the connection status at the 
bottom-left of the tab shows the IQC5000 is connected and in IDLE mode.

Figure 35   Connection Status

If a connection is made immediately (without failure), the user interface will become active. 

Figure 36   Connection Monitor Dialog

In the event of a failure, or if a subsystem is still booting, a connection monitoring window will be shown that allows 
either the monitoring or the canceling of the connection routine.  Once the connection attempt is successful, the 
window will close and the main interface will become enabled.
The connection steps are:
1. Ping/Port Fetch – Ensure network presence and retrieve the device’s port number
2. Unit State – Ensure that the device’s control processor has booted properly
3. Retrieve Trigger Config – Trigger Parameters are retrieved to populate UI fields
4. Param Retrieval – Start/Stop Methods are retrieved to populate UI fields
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5. Storage System Check – The storage device is checked and the list of files currently stored on the storage device 
are retrieved to populate UI fields

6. Other User Connected – Checks to see if another client is controlling the same IQC5000
If the connection halts on the Other User Connected step, the other user may be forcibly disconnected by right-
clicking the step and selecting Override IP Verification.
For more help diagnosing connections problems, see "Connection Problems" on page 69 in the Troubleshooting 
section.

Disconnecting

Press the Disconnect button to disconnect from the IQC5000.
At any time during normal operation, the device may be disconnected in order to shut down IQC Control, or to allow 
operation from another workstation.

Managing IQC5000B-MEM External Storage

If an IQC-MEM module is being used to record data to external storage units, the RAID Selection settings will be 
configurable. 
If a valid RAID isn’t detected, the borders of the UI will flash red and the progress bar will display NO RAID, indicating 
that a RAID needs to be selected before recording can begin.
Specific procedures for creating Single and Dual RAIDS are located in "Advanced RAID Configuration Modes" on 
page 82.

Configuring RAIDs

To configure a RAID, click on the System Tab ( ). 

Figure 37   System Tab

Click on Advanced in the RAID section of the System Tab to bring up the RAID Assembly/Disassembly menu.
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Figure 38   RAID Assembly

Unused disks not currently assembled in a RAID are listed on the left under Available Drives/Media.  Assembled/
Mounted RAIDs and their disks are listed on the right under Detected RAIDs.  Serial number and size are shown for 
each disk. 
Unused disks are available for assembly.  To assemble them as a RAID, click Assemble all RAIDs in the lower-left 
corner of the menu.  This instructs the IQC-MEM module to automatically build the optimal RAID configuration 
based on the disks available.  An alternate approach – only recommended for advanced users – is to select a series 
of unused disks and click Assemble Drives.  Assembled RAIDs are available and ready for use.
After a RAID has been assembled, it will be listed under Detected RAIDs.  Click on a RAID to expand the list of its 
member disks.
To disassemble a RAID, click on the RAID and then select Disassemble.  The disassembled RAID member disks will be 
transferred to the Available Drives/Media list. 
If an external storage unit is attached while the IQC5000 and IQC-MEM are powered on, click the Refresh button in 
the upper-right corner to refresh the disk list.
Specific procedures for creating Single and Dual RAIDS are located in "Advanced RAID Configuration Modes" on 
page 82.

Selecting a RAID for Use

To select a RAID, click on the System tab ( ) to display the RAID controls. Once a RAID has been configured 
for use, it will become available in the RAID dropdown menu(s).  For single external storage unit setup, select the 
configured RAID device from the RAID drop-down menu to select it as the recording device.  For dual external 
storage unit setup, select the desired RAID devices for each I RAID and Q RAID.

RAID Self-Monitoring, Analysis and Reporting Technology (SMART) Data

SMART Data are a collection of metrics that help to communicate the health of an HDD/SSD. SMART Data are 
managed by the HDD/SSD controller and stored on the local disk, and include metrics such as temperature, read 
errors, write errors, and much more. Click on the SMART link next to a configured RAID to view the SMART data for 
the disks that make up that RAID. See Figure 37 on page 46.

Maximum Record File Size

If a maximum recorded file size is desired, use the Max Record File Size option on the System Tab. Setting the Max 
Record File Size to something other than the default setting of None will cause recordings to be split into multiple 
recordings once the max record file size has been met. Subsequent recordings will be followed by a number 
signifying the order in which it was recorded. 
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For example, if a Max Record File Size of 1TB is selected and then 3TB of data is recorded, the first 1TB of recorded 
data will be stored as <Filename>, followed by the next 1TB stored as <Filename2>, and the last 1TB as <Filename3>.

NMEA GPS Port Baud Rate Selection

The baud rate for the NMEA GPS input to the IQC5000 is selectable on the System Tab (Figure 37 on page 46). The 
baud rate for the NMEA GPS serial port may be set to 4800, 9600, or 115200.

System Temperatures

The current temperatures of important internal components may be viewed on the System Tab under System 
Temperatures (Figure 37 on page 46). The text color will change from blue to red when a critically high temperature 
has been met.

Sleeping/Waking the IQC5000B-MEM

The IQC5000B-MEM must be set to sleep before disconnecting the external storage hardware or removing an 
internal SSD RAID module.  This is done by pressing the Sleep button at the top of the window.  The Sleep button will 
then change to Wake.  To use external storage unit or internal SSD RAID module again after being put to sleep, press 
the Wake button.

Changing the IQC5000 IP Address

Click the IP Address link next to the IP address to open the Change IP Address menu.
From here, it is possible to change the local reference to the IP address (in the case that you typed the wrong IP 
address when creating a tab), or change the IP address of the IQC5000.  Enter the new IP address and select to 
either change the local reference or the device IP address, then click Change.

Changing the IQC5000 Subnet Mask

Click the IP Address link next to the IP address to open the Change IP Address menu.  
From here, it is possible to change the subnet mask of the IQC5000. 
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Remote Devices

The IQC Control UI offers users a quick way to manage supported peripheral devices.

Table 23 - Supported Devices for Remote Control

Device Type Vendor Supported Devices Device Listening 
Port

Spectrum 
Analyzer

Keysight UXA 5025

PXA

MXA

EXA

Rohde & Schwarz FSV/FSVR 5025

FSW

DigIConf (Configurable as a subsystem of the 
FSV/FSW)

5026

Tektronix RSA 6000 Series 4000

RSA 5000 Series

Anritsu Field Master Pro MS2090A 9001

Accessory Dowkey RF Switch 10

Adding a Remote Device

To add a device:
1. Click Add Device at the bottom of the Remote Devices panel.  A connection wizard appears.

Figure 39   Add Remote Device

2. Select the device from the list tree of supported devices in the left pane.  The default Device Listening Port for 
the chosen device is pre-filled.

3. Enter the IP Address.
4. If adding a spectrum analyzer, select the Channel the device is connected to.

If adding an accessory, such as the DowKey RF Switch, no channel will be assigned (see "DowKey RF 
Switch" on page 51 for details).
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5. Click Add.
A widget will appear in the Remote Devices section representing the newly added remote device.

Connecting/Disconnecting to a Remote Device

Press Connect within the device’s widget to connect to the device.  When a device is connected, the indicator next 
to the Connect/Disconnect toggle button will be green.

Figure 40   Connecting to Remote Device

Press Disconnect to disconnect from the device.
Note: For Rohde and Schwarz spectrum analyzers: DigIConf must be configured before a successful con-
nection is made.  The default configuration uses the FSW IP address – for any other custom setup, select Con-
figure Device > DigIConf and enter the IP address/port number of the workstation running DigIConf (use the 
loopback address of 127.0.0.1 and port 5026 when running DigIConf locally). 
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Managing Remote Devices

Spectrum Analyzers
After adding and connecting to the spectrum analyzer, press Configure Device on the device’s widget to access the 
device’s remote control panel.

Figure 41   Configure Remote Spectrum Analyzer

For spectrum analyzers, the device control panel displays the Device IDN (typically the manufacturer, model number, 
and firmware version) in the upper-right corner of the control panel window.  Below it is the Server ID: this string is 
the identifier for this device to the IQC Control API command server.  Changing the Server ID modifies the prefix 
used when addressing devices using the API. See the IQC5000 API Programming Manual for more details.
The IP address/port number and channel of the spectrum analyzer, as well as the detected sample rate are shown in 
the upper-left corner.
Vital configurable parameters are available to Get and Set.  By pressing Get, the parameters will be updated in the 
control panel.  By pressing Set, the value entered in the text box will be sent to the remotely controlled 
device.  Press the Refresh button ( ) in the upper-right corner to update all of the parameters at once.
Align (calibrate) the device by pressing Align in the bottom-right corner of the window.  Recording will be 
temporarily unavailable while alignment is in process.
Each channel used for recording must have a separate remote device added.  When using dual channel record, 
spectrum Analyzers can be switched between channels by clicking and dragging from one channel to the other.

Note: For Rohde and Schwarz spectrum analyzers: the DigIConf control menu is available by clicking on the 
DigIConf button in the lower-left corner of the menu.

DowKey RF Switch
The DowKey RF switch allows users to automatically or manually select one of six RF inputs to the spectrum 
analyzer.  The inputs are normally connected to different types of external antennas, optimized for frequency 
coverage in the bands of interest.
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Figure 42   DowKey RF Switch Diagram

After adding the DowKey RF switch as a remote device and connecting to it, press Configure Device on the device’s 
widget to access the device’s remote control panel.  From here, select either Automatic or Manual operation.

Figure 43   DowKey RF Switch Mode Selection

In Manual mode, the user is permitted to over-ride the automated frequency-dependent port assignments by 
manually configuring the Selected Port (switch port assignment).
In Automatic mode, the antenna port is automatically selected for the specified center frequency of the spectrum 
analyzer, according to the frequency limit settings in the DOWConfig.txt configuration file, located in the IQC Control 
program directory.

DOWConfig.txt Syntax and Usage:
P1 : <low frequency limit in Hz> - <high frequency limit in Hz>
P2 : <low frequency limit in Hz> - <high frequency limit in Hz>
P3 : <low frequency limit in Hz> - <high frequency limit in Hz>
P4 : <low frequency limit in Hz> - <high frequency limit in Hz>
P5 : <low frequency limit in Hz> - <high frequency limit in Hz>
P6 : <low frequency limit in Hz> - <high frequency limit in Hz>

 Pn references the RF port to which the antenna is connected
 Frequencies are expressed in Hertz
 Frequencies must not overlap between ports
 All ports must be listed in order
 Unused ports must be entered as 00 – 00
 The file must be named DOWConfig.txt
 The file must be in the following directory: %APPDATA%\XCOM\XCOMControl\config (default: 

C:\Users\USERNAME\AppData\Roaming\XCOM\XCOMControl\config)
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Figure 44   Sample DOWConfig.txt Files

Recording with IQC Control

Note: Select discrete acquisition bandwidths are supported for playback.  If playback of a recording is 
desired, it is recommended to record at a playback-supported acquisition bandwidth.  See "IQC5000 Sup-
ported Playback Acquisition Bandwidths" on page 33.

To set up for recording using IQC Control: 
1. Ensure correct setup:

a. Hardware - See step  “Hardware Setup – Record” on page 8.
b. Network - See step  “Network Setup” on page 15.
c. Spectrum analyzer - see setup for your spectrum analyzer type.

2. Add an IQC5000 tab in IQC Control  - follow steps in "Adding an IQC5000 to IQC Control" on page 42.
3. Connect to the IQC5000 - follow steps in "Establishing Connection" on page 45.
4. Manage IQC5000B-MEM external storage - follow steps in "Managing IQC5000B-MEM External Storage" on 

page 46.
5. Add the spectrum analyzer as a remote device - follow steps in "Adding a Remote Device" on page 49.
6. Connect to the spectrum analyzer - follow steps in "Connecting/Disconnecting to a Remote Device" on page 50.
7. Set the IQC5000 into record mode - follow steps in "Setting the IQC5000 into Record Mode" on page 54.
8. Select the record channel(s) - follow steps in "Channel Selection" on page 54.
9. Identify signal of interest on spectrum analyzer
10. Determine and set recording start/stop methods - follow steps in "Record Modes" on page 54.
11. (Optional) Configure marker settings - follow steps in "Setting up Markers" on page 56.
12. Name and describe the recording - follow steps in "Naming and Describing the Recording" on page 56.
13. Modify center frequency, input power settings, and acquisition bandwidth as desired on the spectrum analyzer, 

or through IQC Control
Once the initial configuration is set, IQC Control recording is readied by arming the IQC5000.

14. Press the Arm for Record button - see "Arming" on page 57
The IQC5000 is now ready to record.  The start method will dictate when the recording is initiated for 
triggered or time of day recordings. Manual recordings can be started/stopped at any time.

15. Press the Record button.  Wait for the desired duration of the recording.
16. Press the Stop button.
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The following sections outline the necessary steps to set up the IQC Control software to record with the IQC5000. 

Setting the IQC5000 into Record Mode

Press the drop-down Mode button and select Record to set the IQC into record mode.

Figure 45   IQC Control Recording Setup

Channel Selection

The IQC5000 is capable of recording 2 streams of LVDS data from similar spectrum analyzers outputting data at the 
same sample rate.  Select to use Channel 1, Channel 2, or both for recording.
The Channel Status Indicators will show the IQC5000 channel is receiving a valid data signal when the circle inside 
area is green.  When the IQC5000 is connected to a spectrum analyzer, the line around the circle will be grey; if a 
spectrum analyzer is not connected correctly, the line will be red.
Clicking on the Status link to the right of the channel checkbox will run a diagnostic for that channel and display 
action required to record using that channel.

Signal Inputs

External input signals can be monitored with these indicators.  When green, a signal is detected; when grey, no 
signal is detected. 

Record Modes

The Recording Configuration pane is where the start/stop methods of the recording are set and displayed.

Figure 46   Record Mode Selection
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Basic Modes
1. Manual Record

The IQC5000 default record mode is Manual Record.  Select the option Manual in the Recording 
Configuration pane. Then click the Record/Stop button after the spectrum analyzer has been armed to 
manually start the recording, and once again to stop the recording.

2. Duration Record
There are 2 types of Duration Record: Timed and Sample Length.  Basic timed recordings are manually 
started and set to complete after the specified amount of time has elapsed.  Basic sample length 
recordings are manually started and set to complete after the specified amount of samples has been 
recorded.
Select the option Duration in the Recording Configuration pane. To specify time, use units ns, us, ms, M, 
or H (nanoseconds, microseconds, milliseconds, seconds, minutes or hours).  To specify a sample length, 
enter the amount of samples without units to record.

Advanced Modes
To access the advanced recording settings, select Advanced and then Configure Recording in the Recording 
Configuration pane.  There are 4 advanced recording tabs.
The Start tab lists the available methods to start a recording, and the Stop tab lists the available methods to stop a 
recording.  There is one additional method on the Stop tab that is not available on the Start tab: Duration.  (This is 
because a recording cannot logically be started on a duration, but instead commences and ends after a specified 
duration.)
The Start Trigger tab contains the trigger settings that are used if Trigger is selected as the Start option.  The Stop 
Trigger tab contains the trigger settings that are used if Trigger is selected as the Stop option.  There are no 
differences between the options available for start trigger and stop trigger.

Table 24 - Advanced Start and Stop Recording Methods
Tab Options Description

Start & Stop Manual Sets the recording to start when the user presses Record, or stop when the user presses the Stop 
button.

Time of Day Sets the recording to start or stop at a time of the day (such as 12:00:00).

Trigger Sets the recording to start on trigger- see Table 25.

Stop Only Duration Records for Timed duration or Sample Length duration. 

To specify time, use units ns, us, ms, M, or H (nanoseconds, microseconds, milliseconds, seconds, 
minutes or hours). 

To specify a sample length, enter the amount of samples without units.

Table 25 - Advanced Trigger Recording Parameters
Trigger Enable Description

Disabled Trigger is not used

Enabled Only the one selected trigger is used

Trigger Edge

Rising Edge Trigger arm looks for rising edge

Falling Edge Trigger arm looks for falling edge
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Figure 47   Advanced Recording Configuration Dialog Boxes

Setting up Markers

Markers can be manually generated by pressing the Mark button on the front panel of the IQC5000.
For precision markers, TTL-level marker source(s) can be attached to Marker 1 and/or Marker 2 on the rear of the 
IQC5000.  A marker will be inserted into the .xmrk marker file of the recording when there is a rising, falling, or both 
rising and falling edge signal.  Set the edge detection under Marker Input.

Naming and Describing the Recording

To the right of the Record/Playback drop down is the File Name text box.
If you wish to provide a description about the recording, enter up to 512 characters into the Recording Comments 
box.  Information such as RF modulation type, spectral behavior, or recording location (if a GPS signal is not 
connected) may be worth entering for future notice.
The option Auto-Increment File Name will append a number to the end of the File Name when a recording has been 
completed, and increment it, readying the next file name for the next recording.  This makes multiple recordings 
within a short period of time a smoother process.

Starting/Stopping Record

To start a recording, the spectrum analyzer must first be armed by clicking Arm.
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Arming

The spectrum analyzer must first be armed before starting a recording by clicking the Arm/Record/Stop toggle 
button, located at the right of the IQC5000 management pane.  This button will change from Arm to Record when 
the unit has successfully armed, from Record to Stop after the recording has been initiated, and from Stop to Arm 
after the recording has stopped.
The Arming process automates configuring often complex settings on the spectrum analyzer for recording.  This 
automation must otherwise be carried out manually when not using IQC Control for recording; i.e., using the front 
panel to record.  

Note: The spectrum analyzer cannot be armed until a file name is specified.
Arming takes a different amount of time depending on the model of spectrum analyzer:

Table 26 - Relative Arming Times for Spectrum Analyzers

Vendor Spectrum Analyzer Relative Arming Time Relative De-Arming 
Time

Keysight UXA 3 seconds 3 seconds

PXA

MXA

EXA

Rohde and Schwarz FSV/FSVR 14 seconds Immediate

FSW

Tektronix RSA 6000 Series Immediate Immediate

RSA 5000 Series

Anritsu MS2090A 1 second Immediate

Starting a Recording Manually
After arming, the recording can be manually started by pressing the Record button.
Stopping
For any recording, pressing the Stop button will end the recording, even if a stop event is specified. 
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Playback with IQC Control

The IQC5000B is capable of I/Q baseband and RF playback. The I/Q Baseband playback is intended for normal use, 
RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.
To set up for playback using IQC Control:
1. Ensure hardware setup  - follow steps in "Hardware Setup – Playback" on page 12.
2. (IQC5000B-MEM) Manage IQC5000B-MEM external storage - follow steps in "Managing IQC5000B-MEM Exter-

nal Storage" on page 46.
3. Set up the RF target (spectrum analyzer, system under test, etc.).
4. Select the file for playback - follow steps in "Selecting a File for Playback" on page 58.
5. (Optional) Select playback channel - follow steps in "Selecting a Playback Channel" on page 59.
6. Select RF or IQ output - follow steps in "Selecting RF or IQ Playback" on page 59.
7.  (Optional) Select the playback loop count - follow steps in "Setting Playback Loop Count" on page 59.
8. (Optional) Set the start/stop positions - follow steps in "Setting Playback Start/Stop Positions" on page 59.
9. (Optional) Set the playback multiplier - follow steps in "Setting the Playback Multiplier" on page 59.
10. Press the Play button to begin playback.
11. (Optional) Press the Stop button to end playback. If playback is not stopped manually, it will continue to play 

until the end of the file, as determined by the loop and start/stop positions.

The following sections outline the necessary steps to set up the IQC Control software for playback with the IQC5000.

Setting the IQC5000 into Playback Mode

Press the drop-down Record/Playback button and select Playback to set the IQC into playback mode. 

Figure 48   IQC Control Playback Setup

Selecting a File for Playback

Select a file for playback by clicking on it in the File System pane (see "File Management" on page 61).  If the 
IQC5000 is in record mode, double-click the file to select it and set the IQC5000 into playback mode simultaneously.
Alternatively, enter the file name for playback into the Selected File text box.

Selecting a Playback Channel

Single channel recordings can be played back through CH1 or CH2 on the rear of the IQC5000.  Select a different 
Playback Channel if desired.  Dual channel recordings are played back as they were recorded (recorded channel 1 is 
locked to CH1, and recorded channel 2 is locked to CH2).
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Selecting RF or IQ Playback

The IQC5000B is capable of I/Q baseband and RF playback. The I/Q Baseband playback is intended for normal use, 
RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.
To play back a recording at an RF fixed frequency of 2.4GHz, select RF under Output.  To play back baseband I/Q data 
to be mixed in an external vector signal generator, select IQ.

Setting Playback Loop Count

The loop count is how many times a selected file should be played.  A loop count of 1 only plays the file once.  A loop 
count of 2 will begin a second playback of the file immediately after the first playback has ended.
To change the loop count, enter the desired value in the Count box.

Setting Playback Start/Stop Positions

The start/stop positions dictate which portion of the file is played back. The default values represent a full file 
playback. 
Enter the start and stop positions in the Start and Stop boxes, respectively.  To specify time, use units ns, us, ms, M, 
or H (nanoseconds, microseconds, milliseconds, seconds, minutes or hours).  To specify a sample length, enter the 
amount of samples without units to playback.
As an example, modifying the start position of a 5 second long file to 1s and the stop position to 3s will play the 2 
seconds of the file after 1 second into the file.

Setting the Playback Multiplier

The Playback Multiplier is an option to shift the bits of the outgoing data through the DAC.  For low amplitude files, 
this makes better use of dynamic range.  Unless it is known that a file is low amplitude, it’s typically best to leave this 
option at x1.
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Playback Calibration

Select the Calibration button to view the current RF and IQ playback calibration parameters on the IQC5000.

Figure 49   Playback Calibration Dialog

There are 3 I/Q pairs which correspond to the playback modes for each channel:

 Channel 1 RF – I, Q
 Channel 1 IQ – I, Q
 Channel 2 IQ – I, Q

The I and Q for each playback mode are calibrated separately, resulting in a total of 6 items to calibrate.  Each item 
has 4 calibration parameters: DC offset, Full Scale Adjust, Phase Adjust, and Aux DAC Data.
Modifying Calibration Values
Each cell value can be modified by clicking in the cell and entering a value within the column parameter value range, 
automatically updating the IQC5000.  Pressing the up and down arrows in the cell accomplishes the same thing; this 
method works well for manually calibrating the unit.
To save all calibration values to the IQC5000, select Save to Flash.  The calibration values will not be saved to 
nonvolatile memory unless they are saved to flash.
Importing/Exporting Calibration Values
To import saved calibration values, select Import and navigate to the desired filepath.  To export calibration values to 
a configuration file, select Export and navigate to the desired file path.
To load the manufacturer calibration values, import the default calibration file at: 
%APPDATA%\XCOM\XCOMControl\config\IQCFlashConfig.xcfg.
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File Management

Managing files on the IQC5000 storage is done in the File System pane on the bottom of the IQC5000 tab.

Figure 50   IQC Control File List

A list of the files currently on the device is displayed, sortable by clicking on the column headers. 
Offloading Files
Offloading (downloading) is the transfer of files from the IQC-MEM storage to the Computer Workstation. 

Figure 51   File Offload

Focusing on one or many files (via Ctrl+A or Ctrl+Mouse) enables the Offload icon ( ) and the Partial Offload icon 
( ).  With a partial offload, it is possible to specify a section of a file by start and end points in time or samples.
After the offload starts, the progress bar will update with the progress.
Set the Offload Directory on the Computer Workstation to the left of the offload icons.
For Microsoft® Windows 7™ users, the maximum supported operating system file size is 16TB.  Because of this, IQC 
Control will automatically split files above16000000458752 bytes, to prevent operating system errors when 
offloading.  Microsoft® Windows 8™ does not have this limitation. 

Uploading Files

Uploading is the transfer of files from the Computer Workstation to the IQC-MEM storage.  Uploading works much 
the same as offloading, except that the file transfer is in the opposite direction, and partial upload is not supported. 
To upload a file, select the Upload icon ( ) and browse to the file to be uploaded.  After the upload starts, the 
progress bar will update with the progress.

File Transfer Methods

The preferred method of file transfer is via the PCIe cable. Using the PCIe offload method is much faster than using 
Ethernet offload; so whenever it possible, it is advisable to use PCIe transfer.  The option to use PCIe transfer will not 
be available unless a valid PCIe connection has been established with the IQC5000, thus Ethernet transfer will be 
selected by default if no PCIe connection detected.
As an alternative to offloading/uploading files with an IQC5000, the IQC5000B-MEM and external storage units can 
be attached directly to a workstation for very fast transfer speeds.  To do so:
1. Connect the hardware as shown in Figure 6 on page 10 (the connection from the IQC5000B-MEM to the 

IQC5000 is not necessary).
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Using IQC5000 with IQC Control
2. Add a control tab as outlined in "Adding an IQC5000 to IQC Control" on page 42, selecting PCI Controlled as the 
control method. 

3. Connect to IQC-MEM and offload/upload files.

Viewing File Information

Vital statistics and marker information for a recorded file can be viewed within the UI.  Select the desired file in the 
file list, then click either View Markers or View Header ( ) in the lower right of the file list to view the 
Information. 

Erasing the IQC5000 Memory

Focusing on one or many files (via Ctrl+A or Ctrl+Mouse) enables the Delete icon ( ).  Clicking this icon will 
confirm the file names to be deleted, and carry out the deletion operation of each selected file.
During the erasure the progress bar in IQC Control will show the progress of the deletion, and the IQC5000 front 
panel will display the status.

Session Logs

The session log is an aggregation of environment variables, error messages, and server communications.  Generate a 
session log when an error is encountered by navigating to Help > Create Session Log. The session log is key to helping 
Bird support identify the cause of the error. Session logs are saved in the directory 
%APPDATA%\XCOM\XCOMControl\logs.

Notifications

 IQC Control incorporates a scale of user notifications to alert the user during operation 
of the IQC5000.  Notifications range in severity from Good to Critical.  Questions (user 
prompts) are also included.
Notifications typically appear as a dialog box to the user after an event trigger.  These 
notifications may be hidden from showing again by selecting the check box Don’t show 
this message again in the lower-left corner of the dialog box. 
The Notification Queue
After a notification has been selected for hiding, the notification does not appear as a 
dialog box, but instead appears in the Notification Queue in the upper-right corner of 
the device window.  Note that some lower-priority notifications only appear in the 
Notification Queue.

Figure 52   Notification Queue

The Notification Queue shows the number of new notifications and the symbol of the highest severity item 
currently in the queue.  Click View All to see a list of all the unviewed notifications, clear the queue, or view the 
notifications as they would normally appear in a dialog box.
Managing Hidden Notifications
Notifications that have been hidden will remain hidden until reset by navigating to Tools > Settings > Disabled 
Dialogs.  Here, all notifications can be reset by clicking Reset All Dialogs.  Click View Disabled Dialogs to view the 
currently disabled notifications and to choose which single notifications to re-enable. 
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Viewing Software and Firmware Versions

The IQC Control Software Version can be viewed in the About menu, accessible at Help > About.  The version 
number and build date can be found in the lower-right corner of the window.

Figure 53   About IQC Control Dialog Box

The IQC Control Change Log can be viewed by clicking View Change Log.
The IQC5000 Firmware Versions can be viewed by clicking on the Versions button at the bottom of the IQC5000 tab.
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Chapter 5 Post Processing IQC5000 Recorded Data

IQC5000 Recording Files

When recordings are offloaded from the IQC5000, 3 separate files (6 for dual channel recordings) are generated with 
the following extensions:

 .xdat – Recording data file, 1 per channel(s) used during record
 .xhdr – Header file containing information about the recording (metadata)
 .xmrk – Marker data file containing time and location data

The xdat Data File

The .xdat data file is a binary data file with the following default format:

 I/Q Samples interleaved
 16-bit integer I, 16-bit integer Q
 Signed, Two’s Complement
 Little Endian

This and further information about the .xdat data file is recorded in the .xhdr header file.

The xhdr Header File

The .xhdr file is of XML 1.0 format and contains information about the recorded data.  The format is detailed in 
Figure 54 on page 65.

Note: The .xhdr file should be parsed as XML, not strictly as text, as escape characters are used where the 
XML standard requires them. 
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Figure 54   IQC5000 xhdr Header File Format
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Post Processing IQC5000 Recorded Data
Listed in the following sections are further descriptions of notable header parameters:
acq_scale_factor
The acquisition scale factor is the floating point number that must be multiplied with each I and Q two byte signed 
integer sample to convert that sample back to the voltage measured on the signal analyzer.  Knowing the actual 
voltage level of the signal is critical when making accurate measurements, and when playing back that signal.
In RSA recordings, a 32-bit I and Q representation of that floating point number is parsed from the RSA.  So for use 
with the IQC, the scale factor must be adjusted by 2^16 because the calculation is based on separate I or Q values.

Converting a Recorded Sample to Voltage
To convert a recorded I or Q sample to voltage:

Where:
Ivoltage, Qvoltage = the voltage level for the I or Q sample
Isample, Qsample = the 16-bit sample I or Q value
SCF = the 32-bit scale factor

Converting a Recording to Power (dBm)
Once the I and Q voltages are known, the samples can be converted to power in dBm:

Pdbm 20 Ivoltage2 Qvoltage2+
0.22360679 2

--------------------------------------------------------------
 
 
 

log=

Where:
PdBm = power in dBm
Ivoltage, Qvoltage = the voltage level for the I or Q sample 

Converting a Recording to Power (dB)
Once the I and Q voltages are known, the samples can be converted to power in dB:

Pdb 20log Ivoltage2 Qvoltage2+=

Where:
PdB = power in dB
Ivoltage, Qvoltage = the voltage level for the I or Q sample
marker_files
The element marker_files will only have a sub-element marker when markers have been recorded – otherwise, 
there will be no marker sub-element.

Ivoltage Isample SCF 65536=

Qvoltage Qsample SCF 65536=
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The xmrk Marker File

The .xmrk marker file is generated when a TTL-level trigger is received through the Marker 1 or Marker 2 inputs on 
the rear of the IQC5000, or by pressing the MARK button on the front panel of the IQC5000.  A marker file is not 
generated if no markers are received.
The default .xmrk marker file format is XML 1.0, detailed in Figure 55 on page 67.
If accessing a IQC-MEM external storage unit directly (that is, without downloading the recording through IQC 
Control), the .xmrk file will be of the binary format BIN2, detailed in Figure 56 on page 67.
See "Markers" on page 35 for more information on recording with markers.

Figure 55   The IQC5000 xmrk Marker File Format – XML

Figure 56   The IQC5000 xmrk Marker File Format – BIN2
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Example xmrk XML File
<?xml version="1.0" encoding="utf-8"?>
<xcom_markers>
<marker marker_number="0" absolute_sample_number="81390" timestamp="2014:013:19:55:41.635163" 
timestamp_source="IRIG" latitude="38°56.9636'" latitude_direction="N" longitude="077°22.2888'" 
longitude_direction="W" altitude="00120" speed="000.0" event_code="marker1_rising"/>
<marker marker_number="1" absolute_sample_number="181388" timestamp="2014:013:19:55:41.637163" 
timestamp_source="IRIG" latitude="38°56.9636'" latitude_direction="N" longitude="077°22.2888'" 
longitude_direction="W" altitude="00120" speed="000.0" event_code="marker1_rising"/>
<marker marker_number="2" absolute_sample_number="281390" timestamp="2014:013:19:55:41.639162" 
timestamp_source="IRIG" latitude="38°56.9636'" latitude_direction="N" longitude="077°22.2888'" 
longitude_direction="W" altitude="00120" speed="000.0" event_code="marker1_rising"/>
<marker marker_number="3" absolute_sample_number="381392" timestamp="2014:013:19:55:41.641156" 
timestamp_source="IRIG" latitude="38°56.9636'" latitude_direction="N" longitude="077°22.2888'" 
longitude_direction="W" altitude="00120" speed="000.0" event_code="marker1_rising"/>
</xcom_markers>

The preceding example XML marker file has 4 markers, beginning at marker_number 0 and ending at 
marker_number 3.
A marker was produced roughly every 2 ms, as illustrated by the differences in the timestamps.  (Dividing the 
difference in absolute_sample_number by the sample_rate located in the header file will also equal delta time.)
The presence of location data (latitude, latitude_direction, longitude, longitude_direction, altitude, and speed) 
indicates that a GPS device was connected.
The timestamp_source indicates that an IRIG device was used in addition to GPS. Due to its higher precision, IRIG 
time is used over NMEA time when both are present.
The recording was made while stationary, illustrated by the speed remaining at 0 and the latitude/longitude never 
changing.
The event_code values show a pattern of markers with the rising edge of marker 1 followed by the falling edge of 
marker 1.  This coupled with the regular delta between timestamps of 2ms suggests that a 250Hz 50% duty cycle 
square wave was used to stimulate markers.
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Chapter 6 Troubleshooting

The IQC5000 error log file can be accessed from within IQC Control by navigating to Help > Logs > View Current Error 
Log.  If any unexpected behavior occurs during use of the IQC5000, consult the error log first for a descriptive error 
message.
If the unexpected behavior cannot be resolved, generate a session log as outlined in "Session Logs" on page 62 and 
provide Bird support with the error and session logs.

Connection Problems

Unable to Connect to Devices through IQC Control Software

If you experience difficulty connecting to either the IQC5000 or RSA when using the IQC Control software, check that 
all antivirus/firewall software (proprietary and stock) allows communication.
1. Allow IQC Control through Microsoft® Windows™ Firewall (this is done initially as part of the installation rou-

tine, but if for some reason it has been removed, follow these steps).
a. Acquire administrative privileges.
b. Navigate to Control Panel > Windows Firewall.
c. On the left side of this window, click Allow a program or feature through Windows Firewall.

Figure 57   Windows Firewall

d. In the Program Selection window, click Allow another program…
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Troubleshooting
Figure 58   Windows Firewall Authorized Programs

e. Next, scroll down to IQC Control and click Add.

Figure 59   Add an Authorized Program to Windows Firewall

f. Next, select all networks in the allowed features window.
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Figure 60   Authorize IQC Control for Windows Firewall

g. Click OK and exit from all firewall and Control Panel windows.
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Troubleshooting
Rohde and Schwarz

DigIConf Will Not Start or Freezes Immediately After Starting
If the Rohde and Schwarz EX-IQ USB cable is moved between control workstations, this may cause the EX-IQ drivers 
to fail.  This may also happen during prolonged use of the EX-IQ.  When this happens, DigIConf will typically fail to 
start correctly.  To fix this:
1. Restart the Computer Workstation.
2. Make sure that the USB cable is plugged into a USB 2.0 port on the Computer Workstation instead of a USB 3.0 

port.  Issues connecting to the EX-IQ have been noted when using USB 3.0.
3. Unplug and re-insert the USB cable.
IQC Control Cannot Connect to FSV/FSW, Failure Connecting to EX-IQ
Check that the firewall on the FSV/FSW is configured to allow DigIConf traffic from the Computer Workstation to the 
FSV/FSW, as outlined in "Configure Windows Firewall on the FSV/FSW to Allow DigIConf Traffic" on page 18.

Failure to connect to the Tektronix RSA SCPI Socket Server

If an initial attempt to connect to the SCPI socket server on the RSA fails:
1. Verify SCPI socket server is running on the SA.

a. Right-click on the TekVISA LAN Server Control icon in the system tray: 
b. Select Server Status from the menu that appears.

Figure 61   TekVISA Selection Dialog

c. Verify Server is running displays in the lower-left corner of the window, and the button in the upper-
right corner displays Stop Socket Server.
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Figure 62   TekVISA Server Window

d. If the SCPI socket server is not running, the button in the upper-right corner should display Start Socket 
Server – press this button if this is the case.

2. If the SCPI socket server is already running, a restart of the SCPI socket server may be necessary to initiate com-
munication.

a. From the same window, toggle the button in the upper-right corner to stop, then start the SCPI socket 
server.

3. To start the socket server during power-on of the RSA:
a. Right-click the TekVISA LAN Server Control icon in the system tray.  Then click Server Properties. 
b. Next, under the Socket Server section, click the check box Start server at system powerup:

Figure 63   TekVISA LAN Server Properties
73



Chapter 7 Maintenance

Updating the Firmware and Software for the IQC5000

The IQC Control software and IQC5000 firmware are packaged together into one installer.  See “Installing the IQC 
Control Software and Loading the IQC5000 Firmware” on page 37

Building a RAID for Use with the IQC5000

External Storage Units purchased from Bird come pre-configured as ext2-formatted Linux mdadm software RAID0 
arrays.  The following instructions detail how to re-build the RAID in case of disaster.
A workstation with an LSI Host Bus Adapter (HBA) and running Linux with the mdadm package installed is necessary 
to format the RAID.   All commands should be issued as root or via sudo.

Build the RAID0 Array Using mdadm

Issue the following command as root or sudo in a terminal session:
mdadm --create -c 512 -e 1.1 /dev/md1 -l0 -n# /dev/sd[x-y]

Where # is the total number of disks used in the External Storage Unit 
And [x-y] is the drive assignment for the External Storage Unit drives

Example: For a External Storage Unit with 16 disks and drives assigned /dev/sdb through /dev/sdq the command 
would be: mdadm --create -c 512 -e 1.1 /dev/md1 -l0 -n16 /dev/sd[b-q]

Format the External Storage Unit as ext2

Issue the following command as root or sudo in a terminal session:
mkfs.ext2 -m 0 -b 4096 -E stride=128 stripe-width=2048 /dev/md1

Note: If the External Storage Unit is larger than 15TB, the “-T  largefile4” option should also be used.
Note: stride= (mdadm chunk size[512k]/ filesystem block size[4k] ) – should be 128.
Note: stripe-width= (stride[128]*# of disks in array) – for a 16 disk External Storage Unit, stripe-width 
should be 2048.

After the External Storage Unit has finished formatting, stop the External Storage Unit by issuing the following 
command:
mdadm --stop /dev/md1
Once the External Storage Unit has been stopped, it is safe to power off and disconnect from the workstation.   
The External Storage Unit is now ready for normal use.
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Routine Maintenance and Cleaning

To prevent the buildup of dust and keep air flowing as well as possible, a routine cleaning of the IQC5000 and 
peripheral devices every 3 months is recommended.  A simple but thorough cleaning with a can of gas duster 
(canned air) around air inlets should be performed.  The location of air inlets, further maintenance steps, and 
maintenance schedule are outlined in Table 27.
Before performing maintenance, power down each component.

Table 27 - Cleaning Instructions

Unit Air Inlet 
Location Cleaning Instructions Schedule

IQC5000 Left and right sides Clean air inlets with gas duster Every 3 Months

IQC-MEM Left and right sides Clean air inlets with gas duster Every 3 Months

External Storage 
Unit

Front and back Clean air inlets with gas duster, making sure to open the front 
latch and spray the front latch filter from the inside out

Every 3 Months

Check that retaining strip on inside of front latch has not shifted Every 3 Months and 
after transport

Check that drives are securely seated by firmly pushing each 
drive from the front

After transport

All other 
peripherals

Perform maintenance according to manufacturer’s instructions

System Temperatures

Important internal components are monitored for temperature via the IQC Control software. These values should be 
monitored to ensure system has proper cooling and to avoid overheating. The internal temperatures can be view of 
the System Tab in IQC control, see "System Temperatures" on page 48.
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Chapter 8 Sanitization

Sanitization Procedure

The following IQC5000 sanitization procedure covers data security requirements, details on nonvolatile memory 
components within the architecture of the device, and instructions on how to sanitize those components of all user 
data, information, and configuration settings.

Supported Products

The following Bird products are covered in the sanitization procedure:

 IQC5000B
 IQC-MEM
 IQC5000B-S08
 IQC5000B-S15

Terms and Terminology

The following terms are used in the sanitization procedure:

 Erase – Removes all data on a device or partition of a device and resets the entire address space to an 
erased state value

 Verify – A byte by byte comparison with either a known image or against the erased state value

 Nonvolatile memory – A memory device that retains information or data when the system is powered off

 User accessible – The user is able to directly access or retrieve the information stored within a memory 
device

 User modifiable – The user can initiate a write to a memory device during normal system operation

The following terminology is used in the table in the sanitization procedure:

 Data Input Methods
o Software/Firmware Operations – A combination of software and firmware is used to control the type, 

quantity, and value of data or information stored
o None – No method exists to collect data or store data to a device

 Type of User Info Stored – Describes the type of user information stored in the device
o User data – Refers to waveforms or other measurement data representing signals connected to the 

instrument by users
o User settings – Refers to instrument settings that can be changed by the user
o None – No user settings or user data is stored in the device 

 Method of Modification – describes how data is modified
o Direct – The user can modify the data directly
o Indirect – The IQC5000B system resources modify the data in a tightly controlled manner and that the 

user cannot modify the data outside of these control boundaries
o None – No modification of this element can take place
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Nonvolatile Memory Devices

Nonvolatile Memory Devices table lists the nonvolatile memory components of the products listed in "Supported 
Products" on page 76.  Detailed procedures to sanitize these devices, if applicable, are may be found in the sections 
following the table.

Table 28 - Nonvolatile Memory Devices

Type Function

Type of 
user 
info 

stored

Method of 
modification

Data 
input 

method
Location

User 
accessible 

or 
modifiable

To sanitize

FLASH Fail Safe boot 
image

None Indirect Software/ 
Firmware 
operations

IQC5000B 
motherboard 
partition 0

No Not applicable, does not 
contain user data or 
settings.  However, the 
IQC sanitization
utility will verify the 
contents of this FLASH 
partition including 
unused areas against
a known image.

FLASH Unused None None Software/ 
Firmware 
operations

IQC5000B 
motherboard 
partition 1

No Not applicable, does not 
contain user data or 
settings.  However the 
IQC sanitization
utility will erase and 
then verify this 
partition.

FLASH Production 
boot image; 
factory 
configuration 
and 
calibration 
settings; 
network 
configuration
settings

None Indirect Software/ 
Firmware 
operations

IQC5000B 
motherboard 
partition 2

Yes The IQC sanitization 
utility will erase and 
then verify this partition 
and then
restore the factory 
configuration and 
calibration settings and 
network configuration
settings.

FLASH Unused None None Software/ 
Firmware 
operations

IQC5000B 
motherboard 
partition 3

No Not applicable, does not 
contain user data or 
settings.  However the 
IQC sanitization
utility will erase and 
then verify this 
partition.

FLASH Production 
boot image

None Indirect Software/ 
Firmware 
operations

IQC5000B 
playback 
board 
partition 0

No Not applicable, does not 
contain user data or 
settings.  However the 
IQC sanitization
utility will erase and 
then verify this 
partition.

FLASH Fail Safe boot 
image

None Indirect Software/ 
Firmware 
operations

IQC5000B 
playback 
board 
partition 1

No Not applicable, does not 
contain user data or 
settings.  However, the 
IQC sanitization
utility will verify the 
contents of this FLASH 
partition including 
unused areas against
a known image.
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FLASH Unused None Indirect Software/ 
Firmware 
operations

IQC5000B 
playback 
board 
partition 2

No Not applicable, does not 
contain user data or 
settings.  However the 
IQC sanitization
utility will erase and 
then verify this 
partition.

FLASH Unused None Indirect Software/ 
Firmware 
operations

IQC5000B 
playback 
board 
partition 3

No Not applicable, does not 
contain user data or 
settings.  However the 
IQC sanitization
utility will erase and 
then verify this 
partition.

FLASH Production 
boot image

None Indirect Software/ 
Firmware 
operations

IQC-MEM 
motherboard 
partition 0

No Not applicable, does not 
contain user data or 
settings. Sanitizing 
would disable
system functionality.

FLASH Unused None None None IQC-MEM 
motherboard 
partition 1

No Not applicable, does not 
contain user data or 
settings.

FLASH Unused None None None IQC-MEM 
motherboard 
partition 2

No Not applicable, does not 
contain user data or 
settings.

FLASH Unused None None None IQC-MEM 
motherboard 
partition 3

No Not applicable, does not 
contain user data or 
settings.

FLASH Production 
boot image

None Indirect Software/ 
Firmware 
operations

IQC-MEM 
Hoyle

No Not applicable, does not 
contain user data or 
settings. Erasing would 
disable system
functionality.

FLASH User files User data Indirect Software/ 
Firmware 
operations

IQC5000B-
ME2

Yes Smelting in licensed 
furnace at or above 
1600ºC.

External 
Storage

User Files User data Indirect Software/ 
Firmware 
operations

IQC5000B-
S08

Yes Smelting in licensed 
furnace at or above 
1600ºC.

External 
Storage

User Files User data Indirect Software/ 
Firmware 
operations

IQC5000B-
S15

Yes Smelting in licensed 
furnace at or above 
1600ºC.

Type Function

Type of 
user 
info 

stored

Method of 
modification

Data 
input 

method
Location

User 
accessible 

or 
modifiable

To sanitize
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Sanitization Procedure for IQC5000B & IQC5000B-MEM

When installing the IQC Control software for the first time on the control computer, it is necessary to perform a full 
firmware update of the IQC5000B system components.  This will result in the creation of a configuration file 
containing the factory default configuration settings and calibration values.  This file will be named 
flash_config_[Datetime].xcfg, where [Datetime] is the date and time the firmware upgrade takes place. the 
configuration file will be stored in the directory 
%APPDATA%\XCOM\XCOMControl\config\flash_configs\[IPv4Address], where [IPv4Address] is the IPv4 address of 
the IQC5000B unit.  Take care to save this file in a safe location as it will be required for use with the sanitization 
utility.

Note: Bird recommends that this file be permanently saved to nonvolatile medium such as a CD-R.  The 
factory default flash configuration file is located in the \FlashConfig on the CD shipped with the IQC5000 sys-
tem.

A backup of the IQC5000B configuration settings is made every time the firmware installer is run, and every time the 
unit is sanitized.
Sanitization Procedure
1. Prior to sanitizing the IQC5000B and the IQC5000B-MEM, make sure that the IQC5000B-MEM is sleeping as 

described in "Sleeping/Waking the IQC5000B-MEM" on page 48.  
2. Power down any and all external storage (i.e., IQC5000B-S08 or IQC5000B-S15) and physically disconnect them 

from the IQC5000B-MEM.
3. Start IQC Control. 
4. Select Tools > Run IQC Installer. The software will exit and launch the firmware installer/sanitizer process.
5. Enter the IP address of the IQC5000B unit to be sanitized, or select the device from the list of previously con-

nected devices.  
6. Once connected to the IQC5000B, click Sanitize this device (see Figure 64).

Figure 64   IQC Firmware Update Window

7. Read the warning and acknowledge the sanitization procedure by selecting Understood – Start Sanitization.  
Note: The sanitization process is lengthy and may take as long as an hour to complete. Progress will be dis-
played in real time.  

8. After Sanitization is successfully completed, a dialog box will appear prompting for the system to be powered 
down.  
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Sanitization
9. Power down the IQC5000B and IQC5000B-MEM.
10. Select Exit to complete the sanitization procedure.
When finished, the IQC5000B and the IQC5000B-MEM are fully cleared of any and all user data, information, and 
configuration settings.  Furthermore, the IQC5000B will power on in a Fail Safe mode and will require that 
production firmware be reinstalled in order to restore system functionality.

Restoring Functionality on the IQC5000B & IQC5000B-MEM

To reinstall the IQC5000B firmware and restore functionality to the IQC5000B & IQC5000B-MEM.
1. Power on the IQC5000B and IQC5000B-MEM.
2. Start IQC Control. 
3. Select Tools > Run IQC Installer. The software will exit and launch the firmware installer/restore process.
4. Enter the IP address of the IQC5000B unit to be restored, or select the device from the list of previously con-

nected devices.  
5. Allow the installer to run.  
6. When the IQC Firmware Update dialog box appears, enter the IP address of the IQC5000B and select Connect.  
7. IQC control will detect the unit is in Fail Safe Mode. Select Restore this device. See Figure 65.

Figure 65   Restore from Fail Safe Mode

8. In the Device Restore dialog, the last back-up configuration file is pre-selected for the restoration process. If 
another configuration is desired, click the browse button and select the desired file.

9. Click Ready - Restore Device. See Figure 66 on page 81.
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Figure 66   Device Restore

10. Allow the restoration is process to continue through to completion.
Note: Progress will be displayed in real time.  

11. After restoration is complete, click Exit to finish the process. 
When complete, the IQC5000B  will be restored to the original factory state.

Sanitization Procedure for IQC5000B-ME2, IQC5000B-S08 and IQC5000B-S15

Currently, Bird does not provide a non-destructive sanitization procedure for the solid state devices used in the 
external IQC5000B storage devices.  Therefore, in order to sanitize these devices, at this time these devices can be 
sanitized by smelting in a licensed furnace at a temperature of at least 1600º C.
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Chapter 9 Firmware Configuration Updates

The firmware updates described in this section are intended to support advanced features/options. These 
procedures are meant as additional options to those described in Chapter 4 "Using IQC5000 with IQC Control" on 
page 37.

Advanced RAID Configuration Modes

The IQC5000 supports enabling certain Features and/or Options using the Advanced option of the Firmware 
Installer.

Single and Dual RAID Mode

Single RAID Mode —(default configuration) Dual Channel operation with up to 150 MS/s sample rates. 
Dual RAID Mode —System must be configured for Dual RAID mode to support Dual Channel operation greater 
than 150 MS/s sample rates.

Firmware Upgrade 

1. Before installing the new firmware, offload any recordings that should be saved. After formatting the RAIDs in 
the new RAID mode, all data will be lost.

2. Run the installer IQC5000_setup_vW.X.Y.ZZZ.exe.
3. The firmware update message box will display:

a. Enter the IP address of your IQC5000 in the IP Address text box and click the Connect button.
Alternatively, if the device has previously been added as a tab in IQC Control select the device from 
the list at the bottom of the window.

4. Once the IQC5000 unit has been detected, select Advanced in the lower right corner of the dialog box. See 
Figure 67.

Figure 67   IQC Firmware, Advanced Selection

CAUTION
Formating RAIDs will erase existing data. Offload external storage unit or internal SSD RAID 

module recordings prior to performing this procedure.
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5. In the MEM/RIF FW Override field, enter one of the following codes. See Figure 68.
 SINGLE - enter this code to switch from Dual RAID mode to Single RAID mode.

 DUAL - enter this code to switch from Single RAID mode to Dual RAID mode.

Note: The codes must be entered in all caps, with no spaces or extra characters.

Figure 68   Advanced Settings Selection Dialog

6. Click Save.
7. Select Configure and run an update on the Firmware Installer Dialog Box. See Figure 67 on page 82.
8. After the firmware installation process has finished, click OK to close the firmware installation.
9. Power off the IQC5000:

a. If IQC-MEM is being used, the IQC-MEM module should be powered off first.
b. Power off the IQC5000.

10. If IQC-MEM is being used with external storage units:
a. Power on the external storage units and allow it to boot for 30 seconds.
b. Power on the IQC-MEM module and allow it to boot for 30 seconds.

11. Power on the IQC5000.
12. Click Finish to close the installer.
13. Proceed with one of the following procedures:

 "Dual RAID Formatting" on page 84.
 "Single RAID Formatting" on page 86.
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Dual RAID Formatting

Note: This section applies to Dual RAID mode only.
1. After the firmware is installed and the IQC-MEM(RIF) and IQC5000 have been power cycled, connect to the sys-

tem in IQC Control.
2. (RIF Only) Select Wake Up to wake the RIF.
3. Select the System tab on IQC Control.
4. Under Select RAIDs, click Advanced. See Figure 69.

Figure 69   IQC Control – Dual RAID System Tab

5. If the system has previously been used in Single RAID mode, select the down arrow next to the existing RAID, on 
the right side of the window. Select Disassemble to disassemble the RAID.
The drives that were once in the RAID should now show in the Available Media section.

Assemble I RAID
6. Disconnect Secondary memory modules:

a. If using internal ME2 memory with IQC-MEM, Unseat the ME2 memory module on the right-hand side 
of the unit. Pull the module out about 1-2 cm so it is no longer powered by the MEM chassis. See 
Figure 70.

b. If using external storage units with IQC-MEM(RIF), disconnect external storage unit #2.

Figure 70   Unseated ME2 Module
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7. Click on the refresh button  to update the Available Media in the IOP RAIDs Dialog. See Figure 71.

Figure 71   IOP RAIDs Dialog Box

8. Select all of the remaining drives in Available Media. 
Select the first drive, hold down Shift, and click on the last drive.

9. Select Create new RAID with Selected Media. 
10. Click Yes at the warning to commence formatting. 

This step will take about 2 minutes to complete.
11. When the formatting process has finished, name the newly created RAID with an “I” in the name, such as nam-

ing it “I-RAID”. 
Use the pull-down arrow to bring up the dialog “Enter Volume Name”.

Assemble Q RAID
12. Reconnect Secondary memory modules:

a. If using internal ME2 memory with IQC-MEM, Insert the ME2 memory module on the right-hand side 
of the unit. 

b. If using external storage units with IQC-MEM(RIF), Reconnect external storage unit #2.

13. Click on the refresh button  to update the Available Media in the IOP RAIDs Dialog. See Figure 71.
14. Select all of the remaining drives in Available Media. 

Select the first drive, hold down Shift, and click on the last drive.
15. Select Create new RAID with Selected Media. 
16. Click Yes at the warning to commence formatting. 

This step will take about 2 minutes to complete.
17. When the formatting process has finished, name the newly created RAID with an “Q” in the name, such as nam-

ing it “Q-RAID”. 
Use the pull-down arrow to bring up the dialog “Enter Volume Name”.

18. Close the IOP RAIDs Dialog Box.
19. Under Select RAIDs in the System tab, select the I RAID and Q RAID as they were named in steps 11 and 17. See 

Figure 72.
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Figure 72   Select I and Q RAIDs

20. The IQC5000 system is now configured for dual RAID operation. Refer to Chapter 3 "Operating Instructions" on 
page 26 to begin using the IQC5000.

Single RAID Formatting

Note: This section applies to Single RAID mode only.
1. After the firmware is installed and the IQC-MEM(RIF) and IQC5000 have been power cycled, connect to the sys-

tem in IQC Control.
2. (RIF Only) Select Wake Up to wake the RIF.
3. Select the System tab on IQC Control.
4. Under Select RAIDs, click Advanced. See Figure 73.

Figure 73   IQC Control – Single RAID System Tab

5. If the system has previously been used in Dual RAID mode, select the down arrow next to each existing RAID, on 
the right side of the window. Select Disassemble to disassemble the RAIDs.
The drives that were once in the RAID should now show in the Available Media section.

6. Select all of the drives in Available Media. See Figure 74.
Select the first drive, hold down Shift, and click on the last drive.
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Figure 74   IOP RAIDs Dialog Box

7. Select Create new RAID with Selected Media. 
8. Click Yes at the warning to commence formatting. 

This step will take about 2 minutes to complete.
9. When the formatting process has finished, name the newly created RAID, as desired. 

Use the pull-down arrow to bring up the dialog “Enter Volume Name”.
10. Close the IOP RAIDs Dialog Box.
11. Under Select RAIDs in the System tab, select the RAID named in step 9. See Figure 73.
12. The IQC5000 system is now configured for Single RAID operation. Refer to Chapter 3 "Operating Instructions" on 

page 26 to begin using the IQC5000.
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Chapter 10 Specifications

FCC Compliance—This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area 
is likely to cause harmful interference in which case the user will be required to correct the interference at his own 
expense.

Specification Value

Logic Level LVDS

Sample Depth 16-bit I&Q

2 Channels of I&Q Accepts both inputs simultaneously

Connector Four 26-pin MDR

Maximum Data Rate (Mbytes/s) 600 at each connector

Spectrum Analyzer Compatibility Keysight: N9010A/B, N9020A/B, N9030A/B, and N9040B
Rohde & Schwarz: FSV, FSVR, and FSW
Tektronix: RSA 5100/6100
Anritsu: Field Master Pro MS2090A

Minimum Span(kHz) 19.531

Span Resolution (kHz) 19.531

Maximum Acquisition Bandwidth 
(MHz)

110 (150 Msamples/s, 16 bits, I&Q)
160 (200 Msamples/s, 12 bits, I&Q)
255 (300 Msamples/s, 14 bits, I&Q)

RF Recording Interface

I & Q Inputs
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Playback Interface

Analog I&Q Outputs

Specification Value

1-dB Bandwidth (MHz) 160 centered at 0 Hz

Power Level (dBm) 0 (fixed)

Amplitude Flatness across 110 MHz 
Bandwidth (dB)

+/-2

VSWR ≤ 1.8:1

Impedance (ohms) 50

Connector SMA Female

2 channels operating simultaneously, baseband, analog

RF Outputs

RF playback capability should be used for testing and system validation only. Do not use RF Playback for normal use.
Channel 1

Specification Value

Center Frequency (MHz) 2400

Information Bandwidth (MHz) 160

Power Level (dBm) 0 to -60 in 1-dB steps

LO Leakage (dBm) -60

VSWR ≤ 1.8:1

Impedance (ohms) 50

Connector SMA Female
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General Specifications

GPS

Specification Value

Protocol ASCII, 8-bit data, one start and one stop bit, no parity

Speed (Kb/s) Selectable: 4800, 9600, or 115200

Active Control Lines RTS, CTS

Connector 9-pin D Female

IRIG-B

Specification Value

Accuracy IRIG-B122

Voltage Levels Amplitude modulated, 3 Vpp, sine wave carrier

Read Rate 1/s

Maximum Number of Time Tags 100,000

Connector SMA Female
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Trigger Functions

Specification Value

Number of Inputs 2

Voltage levels (VDC) 1 to 3 threshold, 5 maximum

Impedance (ohms) 50

Connector SMA female

Latency from Trigger Valid to First 
Sample Write (μs)

<1

Re-Arm Time (ms) <1

Pre-Record Memory (μs) 10

START/STOP RECORDING

Record Types Timed 
Manual

Port Configurations Port 1 
Port 2 
Ports 1 and 2 
Ports 1 or 2

Logic (User-Specified) Leading Edge Valid 
Trailing Edge Valid (after start pulse or same pulse)

START/STOP PLAYBACK

Playback Modes Timed 
Manual 
Looped until Trigger 
Play between Markers

Port Configurations Port 1 
Port 2 
Ports 1 and 2 
Ports 1 or 2

Logic (User-Specified) Leading Edge Valid 
Trailing Edge Valid (after start pulse or same pulse)
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Markers

Specification Value

Number of Inputs 2

Voltage levels (VDC) 1 to 3.3 threshold, 5 maximum

Impedance (ohms) 50

Connector SMA Female

Maximum Allowed per Recording 100,000

Marker Content Date
Time of Day
Latitude 
Longitude 
Altitude 
GS 
Sample Number

Latency (μs) <1 from marker valid at connector to insertion in recorded file

Minimum Time between Markers (ms) 1

Reference Clocks

Specification Value

INTERNAL

Frequency (MHz, +/-ppm) 10, +/-10

EXTERNAL (Provided by external input port if active. Otherwise internal clock signal
is used.)

Required Level (dBm) >0 into 50 ohms

Frequency (MHz, +/-ppm) 10, +/-10

Connector SMA Female

Signal Type Square or Sine

Waveform Storage

Specification Value

Internal Solid State NAND Flash

Internal Size (TBytes per unit (ME2)) 2, maximum 2 units

External Rotating Magnetic RAID 0

External Size (TBytes) 8, 15
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Instrument Control

Specification Value

IQC Control Software Graphical User Interface 
Full Control of Recording 
Playback 
File Manipulation 
Offload and Upload

Operating Environment Single-core desktop or laptop
Microsoft® Windows 7™ or Windows 8™
64-bit OS only
Microsoft® Visual C++ 2013 x64 Redistributable Package
Microsoft® .NET Framework 4.5.2
50 MBytes RAM
100 MBytes free disk space
Mouse

Remote API RJ-45 connection to LAN switch

Front Panel Limited record and playback control (start, stop, record) via membrane 
switches and 2-line LCD

PCIe (Data Offload)

Specification Value

Specification 2.0

Lanes – IQC-MEM 8

Environmental

MIL-PRF-28800F Class 3 except where noted by*

Specification Value

Temperature 0° C to +50° C operating , -20° C* to +71° C storage. 95% relative humidity 
(non-condensing)

Vibration Sinusoidal: 5 to 55 Hz, 0.33 mm amplitude. Random with solid-state 
drives installed: in conformance with MIL-PRF-28800F Class 3

Shock (non-operating) 30g
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Specifications
Power

Specification Value

DC 12 VDC, 6 A maximum (72 W)

Dimensions

Specification Value

Width x Height x Depth (in., mm) 12 x 3.5 x 10.5, 305 x 89 x 266

Weight (lb., kg) 8.5, 3.85

Product Conformity

Specification Value

Electromagnetic Conformance Directive 2014/30/EU, Electromagnetic Compatibility (EMC)
EN 61326-1 and electrical equipment for measurement, control, and 
laboratory use 
ICES-003 Issue 5, August 2012 for a Class A device FCC Title 47 of the 
Code of Federal Regulations (CFR), Part 15 Subpart B for a Class A digital 
device
KN 61000-4 KCC, Korean Standard for EMC Testing
KN 32 KCC, Korean Standard for Electromagnetic Interference
KN 35 KCC, Korean Standard for Electromagnetic Susceptibility

Electrical Safety Conformance Directive 2014/35/EU, Electrical Equipment (Low Voltage)
EN 61010-1:2010 - Safety requirements for electrical equipment for 
measurement, control, and laboratory use - Part 1: General requirements

RoHS Conformance Directive 2011/65/EU, Restriction of Hazardous Substances
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Customer Service

Any maintenance or service procedure beyond the scope of those in this chapter should be referred to a qualified 
service center.
If the unit needs to be returned for any reason, request an Return Material Authorization (RMA) through the Bird 
Technologies website. All instruments returned must be shipped prepaid and to the attention of the RMA number.
Bird Service Center
30303 Aurora Road
Cleveland (Solon), Ohio 44139-2794
Fax: (440) 248-5426
E-mail: bsc@birdrf.com
For the location of the Sales Office nearest you, visit our Web site at:
http://www.birdrf.com
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Limited Warranty
Limited Warranty
All products manufactured by Seller are warranted to be free from defects in material and workmanship for a period 
of three (3) years, unless otherwise specified, from date of shipment and to conform to applicable specifications, 
drawings, blueprints and/or samples. Seller's sole obligation under these warranties shall be to issue credit, repair or 
replace any item or part thereof which is proved to be other than as warranted; no allowance shall be made for any 
labor charges of Buyer for replacement of parts, adjustment or repairs, or any other work, unless such charges are 
authorized in advance by Seller.
If Seller's products are claimed to be defective in material or workmanship or not to conform to specifications, draw-
ings, blueprints and/or samples, Seller shall, upon prompt notice thereof, either examine the products where they 
are located or issue shipping instructions for return to Seller (transportation-charges prepaid by Buyer). In the event 
any of our products are proved to be other than as warranted, transportation costs (cheapest way) to and from 
Seller's plant, will be borne by Seller and reimbursement or credit will be made for amounts so expended by Buyer. 
Every such claim for breach of these warranties shall be deemed to be waived by Buyer unless made in writing 
within ten days from the date of discovery of the defect.
The above warranties shall not extend to any products or parts thereof which have been subjected to any misuse or 
neglect, damaged by accident, rendered defective by reason of improper installation or by the performance of 
repairs or alterations outside of our plant, and shall not apply to any goods or parts thereof furnished by Buyer or 
acquired from others at Buyer's request and/or to Buyer's specifications. Routine (regularly required) calibration is 
not covered under this limited warranty. In addition, Seller's warranties do not extend to the failure of tubes, transis-
tors, fuses and batteries, or to other equipment and parts manufactured by others except to the extent of the origi-
nal manufacturer's warranty to Seller.
The obligations under the foregoing warranties are limited to the precise terms thereof. These warranties provide 
exclusive remedies, expressly in lieu of all other remedies including claims for special or consequential damages. 
SELLER NEITHER MAKES NOR ASSUMES ANY OTHER WARRANTY WHATSOEVER, WHETHER EXPRESS, STATUTORY, OR 
IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS, AND NO PERSON IS AUTHORIZED TO 
ASSUME FOR SELLER ANY OBLIGATION OR LIABILITY NOT STRICTLY IN ACCORDANCE WITH THE FOREGOING.
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Glossary

Acq BW: Acquisition Bandwidth
API: Application Programming Interface

CF: Center Frequency

dB: Decibel(s)
dBm: Decibel(s), with respect to 1 milliWatt

FW: Firmware

GB: GigaBytes (1,000,000,000 decimal bytes)
GUI: Graphical User Interface

HBA: Host Bus Adapter
HDD: Hard Disk Drive

I & Q: In-Phase and Quadrature

LVDS: Low-voltage differential signaling, also known as TIA/EIA-644, is a technical standard that specifies electrical 
characteristics of a differential, serial communications protocol. LVDS operates at low power and can run at very 
high speeds.

ms: millisecond(s)
MSa/s: Mega Samples per second

NIC: Network Interface Card
ns: nanosecond(s)

PCIe: PCI (Peripheral Component Interconnect) Express

RAID: Redundant Array of Independent Disks
RF: Radio Frequency

s: second
SA: Signal Analyzer
SSD: Solid State Drive
SW: Software
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Glossary
TTL: Transistor-Transistor Logic

VM: Virtual Machine
VSG: Vector Signal Generator

µs: microseconds
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